Legal Notices

Warranty

The only warranties for HP products and services are set forth in the express warranty statements accompanying such products and services. Nothing herein should be construed as constituting an additional warranty. HP shall not be liable for technical or editorial errors or omissions contained herein.

The information contained herein is subject to change without notice.

Restricted Rights Legend

Confidential computer software. Valid license from HP required for possession, use or copying. Consistent with FAR 12.211 and 12.212, Commercial Computer Software, Computer Software Documentation, and Technical Data for Commercial Items are licensed to the U.S. Government under vendor's standard commercial license.

Third-Party Web Sites

HP provides links to external third-party Web sites to help you find supplemental information. Site content and availability may change without notice. HP makes no representations or warranties whatsoever as to site content or availability.

Copyright Notices

© Copyright 2000 - 2009 Hewlett-Packard Development Company, L.P.

Trademark Notices

Java™ is a US trademark of Sun Microsystems, Inc.

Microsoft® and Windows® are U.S. registered trademarks of Microsoft Corporation.

Oracle® is a registered US trademark of Oracle Corporation, Redwood City, California.

UNIX® is a registered trademark of The Open Group.
Documentation Updates

The title page of this document contains the following identifying information:

- Software Version number, which indicates the software version.
- Document Release Date, which changes each time the document is updated.
- Software Release Date, which indicates the release date of this version of the software.

To check for recent updates, or to verify that you are using the most recent edition of a document, go to:

   http://h20230.www2.hp.com/selfsolve/manuals

This site requires that you register for an HP Passport and sign-in. To register for an HP Passport ID, go to:

   http://h20229.www2.hp.com/passport-registration.html

Or click the New users - please register link on the HP Passport login page.

You will also receive updated or new editions if you subscribe to the appropriate product support service. Contact your HP sales representative for details.
Support

Visit the HP Software Support web site at:

http://www.hp.com/go/hpsoftwaresupport

This web site provides contact information and details about the products, services, and support that HP Software offers.

HP Software online support provides customer self-solve capabilities. It provides a fast and efficient way to access interactive technical support tools needed to manage your business. As a valued support customer, you can benefit by using the support web site to:

- Search for knowledge documents of interest
- Submit and track support cases and enhancement requests
- Download software patches
- Manage support contracts
- Look up HP support contacts
- Review information about available services
- Enter into discussions with other software customers
- Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many also require a support contract. To register for an HP Passport ID, go to:

http://h20229.www2.hp.com/passport-registration.html

To find more information about access levels, go to:

http://h20230.www2.hp.com/new_access_levels.jsp
Table of Contents

Welcome to This Guide ................................................................. 9
How This Guide Is Organized ..................................................... 9
Documentation Library .............................................................. 11

Chapter 1: Introduction to Service Test Management ................. 15
About Service Test Management ............................................... 15
The Service Test Management Integrated Solution ..................... 16
Advantages of Service Test Management ................................... 17

Chapter 2: Customizing Service Test Management ..................... 19
About Customizing Service Testing ............................................ 19
Customizing the Services Module .............................................. 20
Customizing Service Rules ....................................................... 25
Customizing User Group Permissions ....................................... 29
Customizing Project Entities ..................................................... 31

Chapter 3: Getting Started with the Services Module .................. 35
Accessing the Services Module ................................................. 35
The Services Module Window .................................................... 36
Services Menu Bar ................................................................. 37
Services Toolbars .................................................................... 37
Service Tree ........................................................................... 38

Chapter 4: Creating Services ..................................................... 41
About Creating Services .......................................................... 41
Working with Toolkits ............................................................. 42
Creating a Services Tree .......................................................... 43
Importing Service Definitions .................................................. 44
Creating Manual Services ......................................................... 53
Creating Service Dependencies ............................................... 55
Defining Service Dependencies ............................................... 57
Accessing Services on Secure Sites and Proxy Servers ............... 58
Working with Direct Links ......................................................... 61
Table of Contents

Chapter 5: Managing Services ............................................................63
  About Managing Services .................................................................64
  Viewing and Modifying Services ......................................................65
  Finding Folders and Services ..........................................................66
  Copying Entities ..............................................................................67
  Mailing Services ............................................................................68
  Managing Service Details ..............................................................71
  Managing Service Operations .........................................................75
  Spot Testing Operations .................................................................76
  Adding Attachments to Services ......................................................77
  Removing and Restoring Services ....................................................78

Chapter 6: Working with Service Groups ...........................................81
  About Working with Service Groups ...............................................81
  Creating a Service Group ...............................................................82
  Viewing and Modifying Service Group Details ..................................83
  Viewing Group Coverage ..................................................................84
  Associating Services to Service Groups ..........................................84
  Mailing Group Information .............................................................86

Chapter 7: Generating Service Requirements and Tests ....................89
  About Generating Service Requirements and Tests ..........................89
  Understanding Testing Aspects ......................................................90
  Generating Service Requirements and Tests Automatically ..............93
  Creating Empty Tests .......................................................................98
  Reviewing the Generated Requirements and Tests ..........................99

Chapter 8: Determining Test Coverage .............................................101
  About Determining Test Coverage ..................................................101
  Checking the Aspect Coverage ......................................................103
  Checking the Requirements Coverage ..........................................106
  Viewing the Operations Coverage ................................................111
  Checking the Tests Coverage ........................................................113
  Checking Defect Coverage .............................................................116

Chapter 9: Linking Services to Requirements or Tests .......................119
  About Linking Services to Requirements or Tests ...........................119
  Viewing the Requirement Module’s Services Tab .............................120
  Linking Services to Requirements ..................................................120
  Viewing the Test Lab Module’s Services Tab ....................................121
  Linking Services to Tests ..............................................................122
# Table of Contents

**Chapter 10: Running Service Tests** .................................................... 125
- About Running Service Tests............................................................. 125
- Viewing and Editing Service Tests..................................................... 126
- Configuring Run-Time Settings from Quality Center....................... 128
- Configuring Test Instance Parameters from Quality Center ............ 131
- Running Service Tests....................................................................... 134
- Viewing Test Results........................................................................ 139

**Chapter 11: Updating Services and Analyzing Service Changes** ....... 143
- About Using Change Impact Analysis .............................................. 144
- The Service Change Workflow ....................................................... 145
- Updating Services........................................................................... 146
- Reviewing Service Changes ............................................................ 148
- Creating Test Sets for Service Changes............................................. 151
- Running Test Sets ......................................................................... 154
- Updating the Change Status ............................................................ 154

**Chapter 12: Generating Reports and Documents** ............................ 155
- About Generating Reports and Documents ....................................... 155
- Using Built-in Reports ..................................................................... 156
- Selecting Service Entities ............................................................... 157
- Creating Excel Reports ................................................................... 158

**Chapter 13: Integration with HP Service Test** ................................. 159
- Creating Tests with HP Service Test ................................................. 159
- Emulating Services ........................................................................ 160
- Using Service Emulation ................................................................. 160
- Emulating Services from Quality Center ......................................... 161
- Using Emulated Services in Vuser Scripts ....................................... 162

**Appendix A: Creating Custom Script Generators** ............................ 165
- Creating Custom Script Generator................................................... 165
- Implementing and Registering a Custom Generator.......................... 166
- Adding Registry Keys ..................................................................... 167
- The Script Generator API ............................................................... 168
- Test Generation Flow ..................................................................... 170

**Index** ............................................................................................. 173
Welcome to HP Service Test Management, a complete solution for managing the process of testing services and service changes in service-oriented architecture (SOA) systems. Service Test Management integrates with HP Quality Center to provide a Web-based solution for testing the quality and performance of SOA services throughout the entire application development life cycle.

**Note:** This guide explains how to manage service tests in conjunction with Quality Center. For additional information on using Quality Center, refer to the *HP Quality Center User's Guide.*

---

**How This Guide Is Organized**

This guide contains the following chapters:

**Chapter 1**  
**Introduction to Service Test Management**  
Provides an introduction to the Service Test Management model and its integration with Quality Center.

**Chapter 2**  
**Customizing Service Test Management**  
Describes how to customize the Services module, user group permissions, module access, and project entities for services and service groups.
Welcome to This Guide

Chapter 3  Getting Started with the Services Module
Describes the key elements in the Services module interface, including the various tabs.

Chapter 4  Creating Services
Describes how to create a services tree, import service definitions, access services on secure sites and proxy servers, and manually define services in the services tree.

Chapter 5  Managing Services
Describes how to view and modify service details, definitions, and operation data, generate Excel reports, remove and restore services, and define service dependencies.

Chapter 6  Working with Service Groups
Describes how to create service groups and associate services to service groups.

Chapter 7  Generating Service Requirements and Tests
Describes how to use the Requirement and Test Generation wizard to automatically generate requirements and tests and how to create empty tests.

Chapter 8  Determining Test Coverage
Shows the testing status with graphical displays of test, requirement, and defect coverage.

Chapter 9  Linking Services to Requirements or Tests
Describes how to link services to requirements and tests.

Chapter 10  Running Service Tests
Describes how to edit tests and test configuration settings. Also describes how to create and run tests, and view test results.
Chapter 11 Updating Services and Analyzing Service Changes
Describes how to identify changes in services and analyze their impact on related assets in Quality Center. Also describes how to create and run test sets to test the impact of these changes.

Chapter 12 Generating Reports and Documents
Describes how to create Excel reports to represent your services and their coverage.

Chapter 13 Integration with HP Service Test
Describes how HP Service Test integrates with Service Test Management to let you create tests and emulated services to check and assess the quality of applications and services in your SOA systems.

Appendix A Creating Custom Script Generators
Explains how to extend the capabilities of the Requirement and Test Generation Wizard to include custom test generators using an API.

Documentation Library
The Documentation Library is an online help system that describes how to use the application. When using Service Test Management in the Quality Center application, you can access the Quality Center Documentation Library or the Service Test Management Documentation Library.

➤ Quality Center Documentation Library. When working in any module other than the Services module, you can access the Quality Center Documentation Library in the following ways:

➤ Click Documentation Library in the Help menu to open the Quality Center Documentation Library home page. The home page provides links to the Quality Center guides and references.

➤ Click Help on this page in the Help menu to open the Documentation Library to the topic that describes the current page.
Welcome to This Guide

➤ **Service Test Management Documentation Library.** When working in the Services module, you can access the Service Test Management Documentation Library by clicking Help on this page in the Help menu and then clicking the Home page. The Service Test Management Documentation Library home page provides links to the Service Testing guides.

The Documentation Library is best viewed from a browser with Java support. If you do not have Java support on your browser, download the Sun Java plug in from the Sun Java Web site ([http://java.com/en/index.jsp](http://java.com/en/index.jsp)). Note that if Java support is not available, the Documentation Library automatically opens using the JavaScript implementation. The JavaScript implementation provides the same basic functionality as the Java implementation, however does not allow use of the Favorites tab within the navigation pane.

**Quality Center Documentation Library Guides**

The Quality Center Documentation Library consists of the following guides and references, available online, in PDF format, or both. PDFs can be read and printed using Adobe Reader which can be downloaded from the Adobe Web site ([http://www.adobe.com](http://www.adobe.com)).

**Getting Started** explains how to use the Documentation Library and how it is organized. (Available online.)

**What’s New?** describes the newest features in the latest versions of Quality Center. (Available online and in PDF format.)

You can also access the What’s New? from the Quality Center Help menu. In addition, you can choose Help > Product Feature Movies to view short movies which demonstrate the main product features.

**Readme** provides last-minute news and information about Quality Center.
Welcome to This Guide

**Quality Center Guides:**

**HP Quality Center User’s Guide** explains how to use Quality Center to organize and execute all phases of the testing process. It describes how to define requirements, plan tests, run tests, and track defects. (Available online and in PDF format.)

**HP Quality Center Administrator’s Guide** explains how to create and maintain projects using Site Administration, and how to customize projects using Project Customization. (Available online and in PDF format.)

**HP Quality Center Tutorial** is a self-paced guide teaching you how to use Quality Center to manage the software testing process. (Available in PDF format.)

**HP Quality Center Installation Guide** explains how to install Quality Center on a server machine in a cluster environment or as a stand-alone application. (Available in PDF format.)

**Business Process Testing Guides:**


**HP Business Process Testing Tutorial** provides a self-paced guide that teaches you the basics of Business Process Testing in the Quality Center application. (Available in PDF format.)

**API References:**

**HP Quality Center Database Reference** provides a complete online reference for the project database tables and fields. (Available online.)

**HP Quality Center Open Test Architecture API Reference** provides a complete online reference for the Quality Center COM-based API. You can use the Quality Center open test architecture to integrate your own configuration management, defect tracking, and home-grown testing tools with a Quality Center project. (Available online.)
Welcome to This Guide

**HP Quality Center Site Administration API Reference** provides a complete online reference for the Site Administration COM-based API. You can use the Site Administration API to enable your application to organize, manage, and maintain Quality Center users, projects, domains, connections, and site configuration parameters. (Available online.)

**HP Quality Center Custom Test Type Guide** provides a complete online guide on how to create your own testing tool and integrate it into the Quality Center environment. (Available online.)

**Service Test Management Documentation Library Guides**

The Service Test Management Documentation Library consists of the following guides, available online, in PDF format, or both. PDFs can be read and printed using Adobe Reader which can be downloaded from the Adobe Web site ([http://www.adobe.com](http://www.adobe.com)).

**Readme** provides last-minute news and information about Service Test Management.

**HP Service Test Management User Guide** explains how to use Service Test Management to facilitate the complete application delivery life cycle in SOA environments. (Available online and in PDF format.)

**HP Service Test Management Installation Guide** explains how to set up Service Test Management and deploy it in Quality Center. (Available in PDF format only.)

**HP Service Test User’s Guide** explains how to use Service Test to create scripts for SOA environments. (Available in PDF format only.)
Introduction to Service Test Management

Service Test Management provides SOA services testing and validation that enable you to improve the quality and manage the complexity associated with SOA.

This chapter includes:
➤ About Service Test Management on page 15
➤ The Service Test Management Integrated Solution on page 16
➤ Advantages of Service Test Management on page 17

About Service Test Management

In SOA systems, it is essential that you test the stability and quality of your applications and services before deployment. Service Test Management, in conjunction with other HP testing tools, enables you to test the services you employ to ensure that they perform their intended function and scale to meet the needs of the applications that use them.

Service Test Management adds a Services module in Quality Center that enables you to centrally manage your SOA assets. Using the Services module, you can define, import, and store services in Quality Center. After you define or import services, you can generate a set of requirements and tests to validate the functionality, interoperability, security, boundaries, standards compliance, and performance of services in your SOA environment.
Chapter 1 • Introduction to Service Test Management

You can then run services tests and view results in the Test Plan and Test Lab modules. Service Test Management also provides service change analysis that highlights changes in SOA environments and evaluates the impact that changes in a service may have. Based on these changes, Service Test Management can automatically generate the necessary tests that need to be run.

The Service Test Management Integrated Solution

Service Test Management is an integrated solution that allows you to manage the quality of services in SOA systems. It integrates the following HP products:

➤ **HP Quality Center.** Enables you to centrally manage SOA assets from the Services module. You can define, import, and store services in Quality Center, and generate the necessary requirements and tests.

➤ **HP Service Test.** Enables you to automatically create test scripts for testing your SOA environment. You can edit tests generated using Service Test Management, run tests, view results, reuse services, and create an emulation of a Web service for testing purposes.

➤ **HP LoadRunner/HP Performance Center.** Enable you to perform load testing on services, and monitor and predict their performance under load. HP LoadRunner Analysis allows you to drill down to determine the specific source of bottlenecks and generate actionable reports.

➤ **HP QuickTest Professional.** Enables you to perform functional testing of services. It supports WSDL validation so that you can import descriptions of Web services and create tests to validate them. You can ensure that services are in compliance with corporate standards so they can be reused across multiple applications.

➤ **HP Systinet Registry.** Enables you to import services from the HP Systinet Registry (supports Systinet 2 with Service Pack 1 or later).
Advantages of Service Test Management

Service Test Management provides the following major advantages in testing SOA services:

➤ A complete testing process that includes functional testing and performance testing.

➤ Automatically generated requirements and tests that validate the functionality (positive and negative), interoperability, standards compliance, security, and performance of a service.

➤ Reusable tests that can be combined and extended across teams, providing easier transfer of knowledge and test data.

➤ Change impact testing that highlights changes in SOA services and environments and evaluates the impact that changes in a service may have on different applications.

➤ Automatic script generation using WSDL/client recording validation/regression.

➤ Existing LoadRunner scripts that can be reused without any changes in Service Test, and scripts created in Service Test that can be reused in LoadRunner.

➤ Non-GUI testing that enables SOA services to be tested earlier in the development cycle.

➤ Service emulation allowing you to create a service whenever it is not available, and parameterize its response so that it can be used for early test creation.
Chapter 1 • Introduction to Service Test Management
Customizing Service Test Management

You can customize the Services module, user group permissions, module access, and project entities for services and service groups.

This chapter includes:
➤ About Customizing Service Testing on page 19
➤ Customizing the Services Module on page 20
➤ Customizing Service Rules on page 25
➤ Customizing User Group Permissions on page 29
➤ Customizing Project Entities on page 31

About Customizing Service Testing

You can customize general project data in the Services module. This includes specifying default values for services stored in secure locations and on a proxy server, the default Systinet and UDDI server information, the toolkit parsing order for importing service definitions, the default requirement folder, and user-defined testing aspects.

You can also customize service and service group entities in the same way as you can customize other entities in your Quality Center projects. You can restrict which user groups can add, delete and modify folders, services, and service groups. You can determine whether user groups can update services and service groups, link services and service groups to requirements, and emulate services.

In addition, you can customize access to the Services module for each user group, and customize the system fields and add new user-defined fields.
**Chapter 2 • Customizing Service Test Management**

---

**Note:** This chapter describes the additional customization options available with Service Test Management. For more information on Project Customization, refer to the *HP Quality Center Administrator’s Guide*.

---

**Customizing the Services Module**

You can customize the default connection settings, Systinet server, UDDI server, the toolkit order for importing WSDLs, the default requirement folder, and the default and user-defined testing aspects.

You can instruct Service Test Management to use fuzzy logic when importing WSDL files for .NET toolkits. This allows the WSDL importer to alter the WSDL slightly in order to parse it successfully.

You can also indicate how many times the importer should attempt to parse the WSDL. Each subsequent attempt will further slow down the import process.

**To customize the Services module:**

1. In Quality Center’s navigational toolbar, select **Tools > Customize**. The Project Customization window opens.
2 Click the Service Test Management link. The Service Test page opens. Click the General tab.

![Service Test](image)

3 You can set the default WSDL connection settings for importing a service from a secure location and for accessing a service using a proxy server. In the Connection Settings section, click Edit Default Settings. The Connection Settings dialog box opens. For information on configuring connection settings, see “Accessing Services on Secure Sites and Proxy Servers” on page 58.

4 You can set the Systinet server path displayed by default when a user imports a service from a Systinet registry (Systinet 2 with Service Pack 1 or later). In the Default Systinet Server section, type the name and port of the Systinet server using the following format: http://<hostname>:\<port>/soa.
Chapter 2 • Customizing Service Test Management

5 You can set the UDDI server address URL and version that are displayed by default when a user opens the Import a Service from a UDDI Server dialog box. In the Default UDDI Server section, enter the URL and version of the UDDI server.

6 To set the order in which the toolkits are parsed when importing a WSDL, in the Auto-Detect Toolkit Order section, select a toolkit and use the Move Toolkit Up and Move Toolkit Down buttons.

7 To specify a default requirement for imported services, in the Default Requirements section, click the Browse button. In the Select Requirement dialog box locate a requirement and click OK.

Select a requirement type, Undefined, Functional, or Testing. This will be the default requirement for linking services to tests as described in “Linking Services to Tests” on page 122.

8 For .NET users, enable Use fuzzy logic on import to use a looser set of criteria for parsing services. In the Number of attempts box, specify the number of attempts to try, before aborting the import.

9 Click the Rules tab to create and review custom requirements for your project.

10 To customize the template of the testing aspects displayed in the Requirement and Test Generation wizard, click the Aspects tab. For more information, see “Managing Testing Aspects” on page 23.

11 Click Save to save your settings to the Service Test page.
Managing Testing Aspects

You can customize the template for the system and user-defined testing aspects displayed in the Requirement and Test Generation wizard. Using the Aspects tab, you can add new aspects, modify the properties of system and user-defined aspects, and delete user-defined aspects.

![Aspect Management dialog box](image)

In the Aspect Management dialog box, the icon indicates a system-defined aspect. The icon indicates a user-defined aspect.

To add a testing aspect:

1. In the Project Customization window, click the Service Test Management link. Select the Aspects tab.

2. To add an aspect at the main level, select the Aspect root folder. To create a sub-aspect, select an aspect.

3. Click the New button. The Create a New Aspect dialog box opens.

4. Type the aspect name and click OK. The aspect is added to the aspect tree.

5. In the Description box, type a description of the aspect.
Chapter 2 • Customizing Service Test Management

6 Add details for the requirement to be generated from the Requirement and Test Generation wizard. For more information on generating requirements, see “Generating Service Requirements and Tests Automatically” on page 93.

Tip: To include a service name as part of the generated requirement name or generated requirement description, type %service_name% in the Requirement Name or Requirement Description box. For example, in the Requirement Name box, type %service_name%.my_new_requirement. After you generate the requirement using the Requirement and Test Generation wizard, %service_name% is replaced with the actual service name.

7 Click Save to save your settings to the Service Test page.

To modify a testing aspect:
1 In the Service Test page, click the Aspects tab.
2 Select an aspect from the aspect tree.
3 Update the details. Note that you cannot modify a default testing aspect name.
4 Click Save to save your settings to the Service Test page.

To delete a user-defined testing aspect:
1 In the Service Test page, click the Aspects tab.
2 Select an aspect from the tree and click the Delete button.
3 Click Save to save your settings to the Service Test page.
Customizing Service Rules

Rules let you define the testing aspects to which your service must comply. They help you make sure your testing standards are satisfactory and that the aspects relevant to the service are covered.

When defining a rule, you use the following settings:

➤ **Filters.** Filters indicate the services to which the rule will be applied. For example, if you indicate a filter: *Creation Date [This Week]*, any service created prior to this week, will not be bound by the rule. You can set a rule for a service based on a variety of filters. You can use the conditional and logical operators that are used in all Quality Center filters. For more information, see the *HP Quality Center User’s Guide*.

➤ **Aspects.** The testing aspects that must be covered for the service.

The Services **Rules** tab provides a summary of all of the rules you set.
If your service was not covered by the required aspects, Service Test Management creates an Alert. The Alerts dialog box indicates the violations, and lets you resolve the problem.

For more information about resolving alerts, see “Working with Rule and Change Alerts” on page 74.

**Setting Service Rules**

You can define multiple rules in your project and modify them at any time.

**To set a new rule:**

1. In the Project Customization window, click the Service Test Management link. The Service Test page opens. Click the Rules tab.
Chapter 2 • Customizing Service Test Management

2 Click **New**. The Create New Rule dialog box opens. Type in a name for the rule and click **OK**.

3 In the **Services** section, click **Edit** to open the Filter dialog box.

Scroll to the desired condition and set one or more filters indicating which services need to abide by this rule. You can use asterisks (*) as wild cards. Click **OK**.
In the Aspects section, click Edit to open the Select Aspects dialog box.

Select the desired testing aspects and use the arrows to move them into the Selected Aspects pane. Click OK.

Service Test Management automatically updates a description of the policy based on your selections. To manually provide a description, clear the Use Automatic Text option and enter text.

Click Save in the bottom right corner.

Click Return to exit the Customize Project screen.

To determine which tests violated rules, generate an Excel report as described in Chapter 12, “Generating Reports and Documents.”.

For additional information about rules, see the Rules section in “Managing Service Details” on page 71.
Customizing User Group Permissions

You can customize the permission settings for managing services, service groups, folders, updates, and requirement and test linkage from the Services tab in the Permission Settings dialog box. For more information on user group permissions, refer to the *HP Quality Center Administrator's Guide*.

**To set user group permissions:**

1. In Quality Center, select **Tools > Customize**. The Project Customization window opens.
2. Click the **Groups** link. The Groups page opens.
3. In the **Groups** list, choose the user group for which you want to set permissions. You can only modify user-defined groups—not system groups.
4. Click the **Change** button. The Permission Settings dialog box opens.
5. Click the **Services** tab.
The Services tab displays the following tasks that are available in the Services module:

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Service</td>
<td>User group can add services to the Services module.</td>
</tr>
<tr>
<td>Modify Service</td>
<td>User group can modify services in the Services module. Note that this task enables you to specify the fields that the selected user group can modify.</td>
</tr>
<tr>
<td>Delete Service</td>
<td>User group can delete services from the Services module.</td>
</tr>
<tr>
<td>Link Service to Requirements</td>
<td>User group can link services to requirements in the Services module.</td>
</tr>
<tr>
<td>Update Service/Group</td>
<td>User group can update services or service groups. Note that selecting this task automatically enables the Modify Service task.</td>
</tr>
<tr>
<td>Add Service Folder</td>
<td>User group can add folders to the services tree.</td>
</tr>
<tr>
<td>Modify Service Folder</td>
<td>User group can modify folders in the services tree. Note that this task enables you to specify the fields that the selected user group can modify.</td>
</tr>
<tr>
<td>Delete Service Folder</td>
<td>User group can delete folders from the services tree.</td>
</tr>
<tr>
<td>Add Group</td>
<td>User group can add service groups to the Services module.</td>
</tr>
<tr>
<td>Modify Group</td>
<td>User group can modify service groups in the Services module. Note that this task enables you to specify the fields that the selected user group can modify.</td>
</tr>
<tr>
<td>Delete Group</td>
<td>User group can delete service groups from the Services module.</td>
</tr>
<tr>
<td>Emulate Service</td>
<td>User group can emulate services from Quality Center.</td>
</tr>
<tr>
<td>Add Change</td>
<td>User group can add changes to the Services module.</td>
</tr>
<tr>
<td>Modify Change</td>
<td>User group can modify changes in the Services module. Note that this task enables you to specify the fields that the selected user group can modify.</td>
</tr>
</tbody>
</table>
Select the tasks that the selected user group can use.

Click OK to close the Permission Settings dialog box.

Click Save to save your settings to the Groups page.

### Customizing Project Entities

You can customize the system fields and add new user-defined fields from the Project Entities page. You customize service fields under the **Service** entity, and service group fields under the **Service Group** entity.

An additional aspect of customization is the **Test** entity. You can create new fields for your test and indicate whether a field is mandatory. If you define a field as required, the Test Plan’s **Details** tab shows it as mandatory.

For more information on customizing project entities, refer to the *HP Quality Center Administrator’s Guide*. For detailed information on Quality Center entities and fields, refer to the *HP Quality Center Database Reference*. 
To customize project entities:

1. In Quality Center, select Tools > Customize. The Project Customization window opens.
2. Click the Project Entities link. The Project Entities page opens.
3. Under Project Entities, expand the required entity—Service, Service Group, or Test.
4. Customize the System and User-Defined fields as required.
   To add a new field for a test, expand the Test entity and select User Fields. In the right pane, edit the label, choose a field type, and set a length. To designate the field as mandatory, select Required check box.

5. To add a new field for a service, expand the Service entity and select User Fields. In the right pane edit the label, choose a field type, and set a field length.
6. For User List and Lookup List field types, specify the required information.
7. Click Save to save your settings to the Project Entities page.
8. Click Return to close the Customization window and access the Main Quality Center page.
To view the new fields in the main Services module, select a service and click the Details tab.

When you create a new test manually or through a wizard, Service Test Management prompts you for the required user-defined fields.
3

Getting Started with the Services Module

The Services module enables you to create and manage services and service groups, and generate service requirements and tests in Quality Center.

This chapter includes:
➤ Accessing the Services Module on page 35
➤ The Services Module Window on page 36
➤ Services Menu Bar on page 37
➤ Services Toolbars on page 37
➤ Service Tree on page 38

Accessing the Services Module

You create and manage services and service groups, and generate service requirements and tests in Quality Center from the Services module.

To access the Services module:
1 Log in to your Quality Center project.

2 Click the Services button on the sidebar of the Quality Center window. The Services module opens. For more information on the Services module window, see “The Services Module Window” on page 36.

If the Services button is not displayed in the sidebar:
➤ Check with your system administrator that you are connected to a Quality Center server with Service Test Management. If Service Test Management is not installed on your current Quality Center server, disconnect and reconnect to a server with Service Test Management.
Check that Service Test Management licenses are currently available on the Quality Center server. Contact your Quality Center Site Administrator or refer to the *HP Quality Center Administrator’s Guide*.

**The Services Module Window**

The Services module window is shown below.
Chapter 3 • Getting Started with the Services Module

The Services module contains the following key elements:

➤ **Services menu bar.** Contains menus with Services module commands. For more information, see “Services Menu Bar” on page 37.

➤ **Service toolbar.** Contains buttons for frequently used commands in the Service module. For more information, see “Services Toolbars” on page 37.

➤ **Service tree.** Displays services folders, individual services, and groups in your project, organized in a graphical hierarchy in the services tree. For more information, see “Service Tree” on page 38.

**Services Menu Bar**

The Services menu bar contains the following menus:

➤ **Services.** Contains commands that enable you to create folders and groups, import, update, or restore services, and generate requirements and tests. It also contains commands that enable you to create or use an emulated service. For more information, see “Using Service Emulation” on page 160.

➤ **Edit.** Contains commands that enable you to cut, copy, paste, find, delete, and rename services, services folders, and service groups.

➤ **View.** Contains commands that enable you to expand and collapse services folders, filter, sort, and refresh services.

**Services Toolbars**

The Services toolbar contains buttons for frequently-used commands. The toolbar contains the following buttons:

**New Folder.** Adds a new folder to the services tree below the currently selected item.

**New Group/New Manual Service/ Import Service.** A drop down menu to create a new group or service. You can also import a service based on a WSDL file. For more information on importing service definitions and manually defining services, see Chapter 4, “Creating Services.”
Delete. Removes the currently selected folder or service from the services tree. Deleting a services folder also deletes its subfolders and all of the services in the folders.

Refresh Selected. Refreshes the data for the currently selected folder or service.

Set Filter/Sort. Enables you to locate required service tree items by setting filter or sort preferences. For more information on filtering and sorting, refer to the HP Quality Center User's Guide.

Send by E-mail. Opens the Send E-mail dialog box, enabling you to send service e-mail to recipients selected from a list or to the author of the service. For more information, see “Mailing Services” on page 68.

Service Tree

The Service Tree provides a complete overview of a service, service folder, and service group content. The following tabs are available in the right pane of the Services module:

➤ Details tab. Displays general details and attributes of the selected service or service group. Displays data that is required to identify the selected service, including the JMS details, an ID, service address, and WSDL location. For more information, see “Managing Service Details” on page 71 and “Viewing and Modifying Service Group Details” on page 83.

➤ Operations tab. Displays service operation data for the selected service. For more information, see “Managing Service Operations” on page 75 (only available when selecting a service in the tree hierarchy).

➤ Testing Status tab. Provides a coverage summary for aspects, requirements, operations, tests, and defects. For more information, see Chapter 8, “Determining Test Coverage.”.

➤ History tab. Lists the changes in the WSDL and all rule violations. It also provides an interface to make new changes to the WSDL and create test sets to check the impact of change in the WSDL. For more information, see Chapter 11, “Updating Services and Analyzing Service Changes.”
➤ **Modeling tab.** Provides an interface to graphically associate services with service groups, and to define dependencies between services. For more information, see “Creating Service Dependencies” on page 55.

➤ **Attachments tab.** Lists the files that have been associated with the selected folder, service, or group as attachments. The tab includes an icon ★ if the selected service has attachments. For more information, see “Adding Attachments to Services” on page 77.
Creating Services

You create services by importing service definitions, or by manually defining services in the Services module.

This chapter includes:
➤ About Creating Services on page 41
➤ Working with Toolkits on page 42
➤ Creating a Services Tree on page 43
➤ Importing Service Definitions on page 44
➤ Creating Manual Services on page 53
➤ Creating Service Dependencies on page 55
➤ Defining Service Dependencies on page 57
➤ Accessing Services on Secure Sites and Proxy Servers on page 58
➤ Working with Direct Links on page 61

About Creating Services

You create services in the Services module by adding services to the services tree. You can add services in two ways: you can import service definitions based on a WSDL file, or you can manually define services.

You can import a service definition from a file location, URL, UDDI or Systinet server. You specify the WSDL source file location, a toolkit for parsing the WSDL file, and a requirement coverage option for linking the service to a requirement. Requirement coverage allows you to connect the service to other Quality Center entities, such as tests, test sets, and defects.
You can also import a WSDL that resides in a secure location, or that is accessed through a proxy server. Once you enter the security or proxy information, it remains with the WSDL, enabling service updates and automatic synchronization. When you import a service definition, Service Test Management extracts the service name, service address (endpoint), and operations data from the WSDL file, and stores it in the Quality Center repository.

If you are using services that are not WSDL-based, or if you have no WSDLs available to test, you can create service definitions manually. For details, see “Creating Manual Services” on page 53.

After you import or define a service, you can view and modify its attributes in the Details tab. For more information, see Chapter 5, “Managing Services.”

To assign tests or requirements to your service, see Chapter 9, “Linking Services to Requirements or Tests.”

Working with Toolkits

You can select a toolkit before importing a service definition, and Service Test Management imports the service definition using that toolkit. Service Test Management supports the .NET and Axis toolkits.

When selecting a toolkit, you should match the toolkit to the actual development environment. After you select a toolkit, it becomes permanently associated with the service definition.

Alternatively, you can instruct Service Test Management to detect the appropriate toolkit using Auto-detect (the default setting). Auto-detect attempts to parse the selected WSDLs using the available toolkits, according to the toolkit parsing order set in Project Customization. For more information on customizing the toolkit parsing order, see “Customizing the Services Module” on page 20.
Creating a Services Tree

Services are organized in a graphical hierarchy in the Services tree. You can organize related services in folders and subfolders, and drag and drop folders or subfolders to other folders in the tree.

At the top level of the services tree is the Services root folder, which contains the services folders. Under this folder, you can create custom folders that represent service structures. For example, you might create separate folders to represent services for different applications.

The Obsolete folder contains services that have been removed from the services folders but are still being used by tests stored in Quality Center. For more information on the Obsolete folder, see “Removing and Restoring Services” on page 78.

You cannot rename, move, or delete the Services folder or the Obsolete folder.

To create a folder for your services in the Services tree:

1. Click the Services button in the sidebar. The Services module opens.
2. Select the Services root folder, or another folder in the services tree.
3. Click the New Folder button in the toolbar or select Services > New > New Folder. The New Folder dialog box opens.
4. Enter a descriptive name in the Folder Name box and click OK. A service folder name cannot include any of the following characters: \ ^ *.
   The new folder is displayed under the folder you selected in step 2.
5. Add a textual description of the folder contents in the Description area of the Details tab located in the lower part of the screen.
Chapter 4 • Creating Services

Importing Service Definitions

You can import (and later update) service definitions based on WSDL files from a file location, URL, UDDI or Systinet server. You can also import WSDL files that reside in secure locations, and WSDL files accessed through proxy servers by supplying the relevant authentication credentials. For more information, see “Accessing Services on Secure Sites and Proxy Servers” on page 58.

When you import a service, you can link it to an existing requirement, a new requirement, a default requirement that Service Test Management creates for you, or you can link it later. Requirement coverage connects services to other Quality Center entities (tests, test sets, and defects), which helps you to keep track of the service and ensure compliance with your requirements throughout the testing process. For more information on requirement coverage, see “Creating Service Dependencies” on page 55.

Note: If a WSDL file has multiple service definitions, a service entity is created for each definition.

To import a service definition:

1. Click the Services button in the sidebar. The Services module opens.
2. In the services tree, select the folder into which you want to import the service definition.
3 Click the **Import Service** button or click Ctrl-L. The Import Services dialog box opens.

4 Select an import option:

   ➤ **File.** Imports a service definition based on a WSDL file from a file system.
   
   ➤ **URL.** Imports a service definition based on a WSDL file from a URL.
   
   ➤ **UDDI.** Imports a service definition based on a WSDL file from a UDDI server.
   
   ➤ **Systinet.** Imports a service definition based on a WSDL file from a Systinet server.
5 Click Add, and follow the import procedures for the selected option.
   ➤ For importing from a file, see “Importing Service Definitions from a File System” on page 48.
   ➤ For importing from a URL, see “Importing Service Definitions from a URL” on page 49.
   ➤ For importing from a UDDI, see “Importing Service Definitions from a UDDI Server” on page 50.
   ➤ For importing from Systinet, see “Importing Service Definitions from Systinet” on page 51.

After selecting the service definitions you want to import, the selected services are displayed in the Import Services dialog box.

6 Configure the Advanced settings (optional). If you cannot see the Advanced options, click the Expand arrows at the bottom right of the dialog box.

7 In the Import with toolkit box, select the toolkit for parsing the WSDL file. To instruct Service Test Management to detect the appropriate toolkit, select Auto-detect (the default setting). For more information on selecting a toolkit, see “Working with Toolkits” on page 42.

8 Browse for or manually specify a folder for the service. This folder corresponds to the folders in the left pane’s tree hierarchy.

9 Connection settings enable you to set credentials required to access a WSDL located on a secure site, and to access a WSDL using a proxy server. To configure connection settings, click Configure, and follow the instructions described in “Accessing Services on Secure Sites and Proxy Servers” on page 58. If connection settings are specified, they are displayed in the Connection Settings box.

Note: Connection settings are only available for WSDLs imported from a URL or UDDI.
10 Click **Import** to import the selected service definitions. The Import Log dialog box opens and lists the import process in the Log window.

To automatically close the Import Services dialog box after the import process has finished, select **Close dialog box when process finishes**.

By default, Quality Center pauses the process each time it finds an error, and displays the error message in the Import Services dialog box. To continue with the import process, click **Continue**, or click **Stop** to end the process. If you do not want to view errors during the import process, clear the **Pause on error** check box.

11 To stop the import process at any time, click **Stop**.

12 When the import process has finished, click **Finish** to close the dialog box.
The successfully imported services are added to the services tree below the folder you selected in step 2 with the following icon:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>WSDL imported from file</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>WSDL imported from URL</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>WSDL imported from a UDDI</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>WSDL imported from Systinet</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>WSDL Definitions created manually</td>
</tr>
</tbody>
</table>

**Importing Service Definitions from a File System**

You can import service definitions based on WSDL files from a file system by browsing the file system, and selecting the files you want to import.

**To import service definitions from a file system:**

1. After performing steps 1-5 of “Importing Service Definitions” on page 44, the Open dialog box opens with **Files of type** set to **WSDL files (*.wsdl and *.xml)**.

2. Browse to the directory where the WSDL files are located, select the files you want to import, and click **Open**. The Open dialog box closes, and the files are added to the import services list in the Import Services dialog box.

3. To add WSDL files from other directories, click **Add**, and repeat this process.

4. To remove a service from the WSDL list, select the service and click the **Delete** button.

5. Continue with step 6 on page 46.
Importing Service Definitions from a URL

You can import service definitions based on WSDL files from a URL, by browsing Web pages and selecting the desired URL, or by typing the URL directly.

To import service definitions from a URL:

1. After performing steps 1-5 of “Importing Service Definitions” on page 44, a Web browser opens.

2. In the Address box, type the URL, or navigate to the URL in Internet Explorer.

3. Close the browser. The selected URL is added to the import services list in the Import Services dialog box.

4. To import services from other URLs, click Add, and repeat this process.

5. To remove a service from the WSDL list, select the service and click the Delete button.

6. Continue with step 6 on page 46.
Importing Service Definitions from a UDDI Server

You can import service definitions based on WSDL files from a UDDI server. You can search for services published on a UDDI server by typing a service name.

To import a service definition from a UDDI server:

1. After performing steps - 5 of “Importing Service Definitions” on page 44, the Search for Service in UDDI dialog box opens.

2. Insert the UDDI address or choose one from a previously loaded WSDL. Select a version number, 2 or 3. Click Go. The dialog box lists all of the available services.

3. In the Available Services pane, sort the services by the most relevant column: Service Name, Service ID, Description, WSDL Location, or UUID.

4. Use the right-facing and left-facing arrows to move services from the Available Services pane to the Selected Services pane.
5 Click OK. The services are added to the services list in the Import Services dialog box.

6 To remove a service from the UDDI Services list, select the service and click the Delete button.

7 Continue with step 6 on page 46.

**Importing Service Definitions from Systinet**

You can import service definitions based on WSDL files from a Systinet server. You can search for services on a Systinet server by typing a service name or by typing a REST request.

---

**Note:** Only a Systinet 2 server with Service Pack 1 or later is supported.
To import a service definition from Systinet:

1. After performing steps 1-5 of “Importing Service Definitions” on page 44, the Search for Service in Systinet dialog box opens.

2. Insert the Systinet address or choose one from a previously loaded WSDL. Click Go. The dialog box lists all of the available services.

3. In the left pane, **Available Services**, sort the services by the most relevant column: **Service Name**, **Service ID**, **Description**, **WSDL Location**, or **UUID**.

4. Use the right-facing and left-facing arrows to move services from the right pane to the right pane, **Selected Services**.
5 Click **OK**. The services are added to the Systinet services list in the Import Services dialog box.

6 To remove a service from the Systinet Services list, select it and click the **Delete** button.

7 Continue with step 6 on page 46.

**Creating Manual Services**

If you are using services that are not WSDL-based, or you have no WSDLs available to test, you can create empty service definitions under the active folder, and manually update the service attributes. This enables you to link existing requirements and tests to your services, even before the service is deployed.

Alternatively, you can use the Service Emulation tool to create an emulation of your service. For more information, see “Emulating Services” on page 160.
To create a manually defined service:

1. In the services tree, select the folder into which you want to create the service definition, and choose **Services > New > New Manual Service**. The New Service dialog box opens.

![New Service dialog box](image)

2. In the **Service Name** box, type a name for the service. The service name cannot exceed 255 characters or include any of the following characters: % * \ | ' : " / < > ? @ # $.

3. Specify the details of the service:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Assigned To</strong></td>
<td>The name of the user to whom the service implementation is assigned.</td>
</tr>
<tr>
<td><strong>JMS Request Queue</strong></td>
<td>The name of the request queue</td>
</tr>
</tbody>
</table>
Enter text for a **Description** of the service or **Comments** in the respective tabs.

To add attachments, click the **Attachments** button and follow the guidelines described in “Adding Attachments to Services” on page 77.

Click **Submit**. The service is added to the services tree below the selected folder.

### Creating Service Dependencies

Service dependency defines a relationship between two or more services. As the operations of these linked services change, you can detect changes and track their impact on the linked services.

You can define the dependencies using Service Test Management’s **Modeling** tab. The **Modeling** tab uses a graphical display to portray all of the service dependencies.
You select services and add them to a modeling diagram. In the following example, the *AddrBook* service is associated with the service group, *grp1*. The *Calc_1* service is dependent on *AddrBook*, while *AddrBook* is dependent on *MyService1*.

An arrow indicates a dependency. The direction of the arrow indicates the dependency. The *Dependency To* grid indicates services that are impacted by a selected service. The *Dependency From* grid indicates services that impact a selected service.

**Tip:** You also use the *Modeling* tab to associate individual services to service groups. For more information, see “Viewing Group Coverage” on page 84.
Defining Service Dependencies

You can indicate dependencies between services. Although you specify the dependent services, the dependencies are actually per operation. In the Dependency Details, you can specify the operation that affects the dependency, or if you do not know which one, you can specify all of them.

To set a dependency:

1. In the services tree in the left pane, select the service for which you want to create dependencies.
2. Select the Modeling tab.
3. Click the Select Entities button to open the Services list in the right pane.
4. Expand the folders and select a service.
5. Click the arrow to open the transfer menu.
   a. To add a service that is dependent on the base service, click Add Service Dependency (Dependency To).
   b. To add a service upon which the base service is dependents, click Add Service Dependency (Dependency From).

The Dependency Details dialog box opens.

6. Select the operations that call one another:
   a. In the `<service name1>` Operation list box, select an operation or `<All>`.
   b. In the `<service name2>` Operation list box, select the operation to which you want to create a dependency or `<Any>` if you are unsure which one.
Chapter 4 • Creating Services

1. Click OK to add the dependency between the service operations to the list.

7. Repeat the above steps to add other dependencies details.

8. To edit a dependency, click on an arrow connecting two services to view the Dependency Details section in the bottom pane. Click the Edit button.

9. Rearrange the services in the Modeling tab by dragging the service name icon to desired position.

10. To remove a dependency, select it in the Dependencies Details grid and click the Delete button.

Accessing Services on Secure Sites and Proxy Servers

When importing WSDL files from a URL or UDDI server, the WSDL may require authentication if it resides in a secure location. Occasionally, access to the WSDL may be through a proxy server. Service Test Management supports the importing of WSDLs using security and WSDLs accessed through proxy servers.

After you enter the security or proxy information, it remains with the WSDL, visible through the Connection Settings box in the Import Services dialog box. If you enable the Keep up to date option to allow automatic synchronization, Service Test Management accesses the WSDL at its source using the authentication or proxy server settings.

Service Test Management supports importing WSDLs using security and WSDLs accessed through proxy servers, using basic and NTLM authentication.

It is recommended that you enter the authentication or proxy information while importing the WSDL. If however, the settings changed, you can modify them through the WSDL Definition tab.
Note: You can set the default WSDL connection settings in the Project Customization window. For more information on customizing the connection settings, see “Customizing the Services Module” on page 20.

To configure the connection settings:

1. Select the WSDLs you want to import as described in “Importing Service Definitions” on page 44.

Note: You cannot configure connection settings for a service definition imported from a file system or a Systinet server.

2. In the Connection Settings section, click Configure. The Connection Settings dialog box opens.

![Connection Settings dialog box]

- **Authentication**
  - Access the WSDL located in a secure location, using the following authentication credentials:
    - Use default credentials
    - User name: [input field]
    - Password: [input field]

- **Proxy**
  - Access the WSDL using the following proxy server and credentials:
    - Use default credentials
    - User name: [input field]
    - Password: [input field]

[OK] [Cancel]
Chapter 4 • Creating Services

3 To specify authentication details for accessing a WSDL on a secure site, in the Authentication section, select **Access the WSDL, located in a secure location, using the following authentication credentials**, and choose one of the following authentication options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use default credentials</td>
<td>Uses the Windows logon credentials of the user logged on to the machine for authentication.</td>
</tr>
<tr>
<td>User name and Password</td>
<td>Enter the user name and password to be used for authentication. Users that are not in the default domain must also type the domain before the user name. For example, domain1/alex_qc.</td>
</tr>
</tbody>
</table>

4 To specify details for accessing a WSDL through a proxy server, in the Proxy section, select **Access the WSDL using the following proxy server and credentials**. Type the **Proxy server** and **Port** used to access the WSDL, and choose one of the following connection options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use default credentials</td>
<td>Uses the Windows logon credentials of the user logged on to the machine.</td>
</tr>
<tr>
<td>User name and Password</td>
<td>Enter the user name and password to be used to access the proxy server.</td>
</tr>
</tbody>
</table>

5 Click **OK** to apply your settings. Once a service has been successfully imported, its connection credentials are stored in Service Test Management. If you attempt to import the secure service before specifying the necessary credentials, Service Test Management prompts you to enter the information. If you supply the incorrect, or no credentials, Service Test Management is unable to import the file.

6 To update or modify the authentication or proxy connection settings after you import a service, click the **Details** tab, and click the **Connection Settings** button. Edit the required fields in the Connection Settings dialog box, and click **OK**.
Working with Direct Links

You can use direct links to access specific views and services. You enter the direct link into your browser to access the desired view.

When working with Systinet, you can save the direct link to the import screen, enabling you to import services quickly.

You can save these links for future reference, or send them to others so that they can access a specific view or service. For more information, see “Mailing Services” on page 68.

The direct links use the following format:

td://<project_name>.<domain>.<server:port>/qcbin/100?

The following table describes the format for the specific views:

<table>
<thead>
<tr>
<th>View</th>
<th>Syntax</th>
</tr>
</thead>
<tbody>
<tr>
<td>Systinet Import</td>
<td>ImportSystinet&amp;SystinetID=[SYSTINET_KEY]&amp;Environment=ENVIRONMENT&amp;Uuid=[UUID]</td>
</tr>
<tr>
<td>Services</td>
<td>EntityType=IStmService&amp;EntityID=&lt;service id&gt;&amp;View=&lt;service tab type&gt;</td>
</tr>
<tr>
<td>Services Group</td>
<td>EntityType=IStmGroup&amp;EntityID=&lt;group id&gt;&amp;View=&lt;group tab type&gt;</td>
</tr>
</tbody>
</table>

The <service tab type> can have one of the following values: ServiceDetailsView, OperationsView, StatusView, HistoryView, ModelingView, or AttachmentsView.

The <group tab type> can have one of the following values: ServiceDetailsView, StatusView, ModelingView, or AttachmentsView.

Italic text indicates optional parameters.
The following example shows the complete link for opening the import service dialog box for a Systinet service.

```
https://sanity_iteration_5.DEFAULT.labm1soa08.devlab.ad:8080/qcbin/100?Action=ImportSystinet&SystinetID=https%3A%2F%2Fb208.devlab.ad%3A8543%2Fsoa%2Fyintranet%2Fplatform%2Frest%2Frepository%2FserviceArtifacts%2Fee65948f-5028-4316-b5f3-2fb5e02ef456&Environment=testing&Uuid=ee5d948f-5028-4316-b5f3-2fb5e02ef456
```

You can set the Service ID in the Details tab. The following example shows the complete link for viewing the service with an ID of 6, in the default Details tab.

```
https://sanity_iteration_5.DEFAULT.labm1soa08.devlab.ad:8080/qcbin/100?EntityID=6
```

The following example shows the complete link for viewing the service with an ID of 6, in the History tab.

```
https://sanity_iteration_5.DEFAULT.labm1soa08.devlab.ad:8080/qcbin/100?EntityID=6&View=HistoryView
```

You can manually type in these links and then save them as shortcuts. Alternatively, select the service and choose Copy from the right-click menu. Paste the contents of the clipboard into a text file and edit it as required.
Managing Services

After creating a service, you can view and modify service definitions and details, view operations and operation parameters, and add attachments. You can also remove and restore services and service groups and associate service groups with services.

This chapter includes:
➤ About Managing Services on page 64
➤ Viewing and Modifying Services on page 65
➤ Finding Folders and Services on page 66
➤ Copying Entities on page 67
➤ Mailing Services on page 68
➤ Managing Service Details on page 71
➤ Managing Service Operations on page 75
➤ Spot Testing Operations on page 76
➤ Adding Attachments to Services on page 77
➤ Removing and Restoring Services on page 78
About Managing Services

After you import a service definition or manually define a service, you can view and modify service definitions and details. You can also generate Excel reports and delete service folders or remove services that are not required.

You can manage service data using the following tabs:

- **Details tab.** Displays general details and attributes of the selected entity: a folder, service, or service group. Displays data that is required to identify the selected service, including the JMS details, an ID, service address, and WSDL location. For more information, see “Managing Service Details” on page 71 and “Viewing and Modifying Service Group Details” on page 83.

- **Operations tab.** Displays service operation data for the selected service. For more information, see “Managing Service Operations” on page 75 (only available when selecting a service in the tree hierarchy).

- **Attachments tab.** Lists the files that have been associated with the selected folder, service, or group as attachments. The tab includes an icon if the selected service has attachments. For more information, see “Adding Attachments to Services” on page 77.

- **Testing Status tab.** Provides a coverage summary for aspects, requirements, operations, tests, and defects. For more information, see “Checking the Tests Coverage” on page 113.

- **History tab.** Lists the changes in the WSDL and all rule violations. It also provides an interface to make new changes to the WSDL and create new test sets. For more information, see “Reviewing Service Changes” on page 148.
Chapter 5 • Managing Services

Viewing and Modifying Services

You can view and modify services and service folders in the services tree. When the Services module is first accessed, the services tree displays only the highest level folder or services in the hierarchy.

➤ An Alert icon ! adjacent to a service indicates that the WSDL has changed or that there has been a rule violation. To open the Alerts window, click on the icon. For information on resolving alerts, see “Working with Rule and Change Alerts” on page 74. For more information on viewing changes, see “Reviewing Service Changes” on page 148.

➤ To expand a folder in the tree, click the expand symbol ⊃ to the left of the folder name, or double-click the folder. Alternatively, choose View > Expand.

➤ To collapse a folder in the tree, click the collapse symbol ⊂ to the left of the folder name, or double-click the folder. Alternatively, choose View > Collapse.

➤ To change a folder or service name in the services tree, select the folder or service and click it. Alternatively, choose Edit > Rename. Then edit the item name and press ENTER.

➤ To move a folder or service in the tree, you can drag and drop the folder or service to the required position in the tree. Alternatively, right-click the folder or service, and choose Cut. Then right-click the required folder into which to paste the folder or service and choose Paste.

➤ To refresh a folder or service in the tree, select the folder or service and click the Refresh Selected button in the toolbar. To refresh all the folders and services in the tree, select the Services root folder and click the Refresh Selected button in the toolbar.

➤ To filter or sort the services in the tree, click the Set Filter/Sort button in the toolbar. Any currently applied filters or sort orders are displayed under the service tree toolbar. For more information on filtering and sorting a tree, refer to the HP Quality Center User Guide.
Chapter 5 • Managing Services

Finding Folders and Services

You can search for a particular folder or service in the services tree using the Find command. If you have applied filters to the tree, the search is restricted to the folders and services currently displayed.

To find a value:

1. In the services tree, select the folder or service that you want to search, and choose Edit > Find. The Find dialog box opens.

2. Select an Entity Type: Folder, Service, or Group.

3. In Find in Field, select the field to search. The available fields differ for each of the entity types. The fields correspond to those in the Details tab.

4. In the Value To Find box, type or select the value to find.

5. To refine the search, click More to expand the dialog box. You can specify case sensitivity, enable wildcards, or require an exact match.

6. To use a wildcard, select Use Wildcards and specify the partial string.

7. Click Find Next. Quality Center attempts to locate the folder, service, or group. If the search is successful, Quality Center selects the first available match in the Services tree.

8. To move to the next match, click Find Next again.
Copying Entities

You can copy an existing folders, services, or groups and paste it to another location in the services tree, or to another project. When copying a service to another project, the source and target projects must be open in separate browsers.

If a copied entity has the same name as an existing one, Quality Center copies it to the new location with a suffix, _Copy_<copy_number>.

When you copy a folder, services and groups within the folder are also copied. You can then use the copied structure as the basis for new services.

To copy an existing entity:

1. In the services tree, right-click the folder, service, or group that you want to copy, and choose Copy.

2. Right-click the folder into which you want to paste the new folder or services, and choose Paste. The folder or services is copied to the new position in the services tree.

3. If you want to change the name of the copied folder or service, right-click the folder or service in the tree, choose Rename, and then enter a new name.

4. To modify settings of the copied service, select the service in the tree, and modify the settings in the Details tabs.
Chapter 5 • Managing Services

Mailing Services

You can send e-mail about an entity (folder, service, or group) to other users. This enables you to routinely inform users about the status of your services. A link is included in the e-mail message that enables the recipient to go directly to the service.

**Note:** By default, Quality Center sends e-mail in HTML format. To send e-mail as plain text instead, edit the MAIL_FORMAT parameter in the Site Configuration tab in Site Administration. For more information, refer to the *HP Quality Center Administrator’s Guide*.

To mail an entity:

1. In the services tree, select an entity.
2. To send a service to a user, click the **Send by E-mail** button. The Send E-mail dialog box opens.
3 To add a recipient name, type a valid user name. Alternatively, click the To button or CC button to select users. The Select Recipients dialog box opens.

You can sort the users list, search for users, group users by user groups, and select users from the list or from a group tree. Select the users or user groups to which you want to send the e-mail, and click OK.

4 In the Subject box, type a subject for the e-mail.

5 Choose whether you want to include the Attachments of the service.

6 In the Additional comments box, add any comments you may have.

7 To check the spelling in the dialog box:

   ➤ Click the Check Spelling button to check the spelling for the selected word or text box. If there are no errors, a confirmation message opens. If errors are found, the Spelling dialog box opens and displays the word together with replacement suggestions.

   ➤ Click the Spelling Options button to open the Spelling Options dialog box, enabling you to configure the way spelling is checked.

   ➤ Click the Thesaurus button to open the Thesaurus dialog box and display a synonym, antonym, or related word for the selected word. You can replace the selected word or look up new words.
Click the **Custom** button to customize the e-mail. In the Select Fields dialog box, specify fields to include in the e-mail. See “Selecting Fields to Display in Email” on page 70.

Click **Send** to send the e-mail.

---

**Tip:** You can send direct URL links to services and their views by right-clicking the service and copying the URL. For more information, see “Working with Direct Links” on page 61.

---

**Selecting Fields to Display in Email**

You can determine which fields to include in the e-mail message. The available fields may vary depending on the level of your selection—folder, service, or group.

**To customize the information in your e-mail:**

1. In the Send E-mail dialog box, click the **Custom** button.

2. In the Select Fields dialog box, use the arrows to move the desired fields from the **Available Fields** to the **Visible Fields** section.
Managing Service Details

The **Details** tab lets you view and modify general details and attributes of the service. You can also view the WSDL location, override the service address, and modify the connection settings.

**To view or edit service details:**

1. Click the **Services** module in the left pane.
2. Select a service in the services tree, and click the **Details** tab.
The **Details** tab contains the following information:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Assigned To</strong></td>
<td>The name of the user to whom the service implementation is assigned.</td>
</tr>
<tr>
<td><strong>Created By</strong></td>
<td>By default, the name with which you logged in. You can edit this field and specify a different name. This is useful for sorting the services in reports.</td>
</tr>
<tr>
<td><strong>Creation Date</strong></td>
<td>The date the service was created in the services tree</td>
</tr>
<tr>
<td><strong>Description</strong></td>
<td>The description of the service in the WSDL file or on the UDDI or Systinet server that is displayed by default when importing the service.</td>
</tr>
<tr>
<td><strong>JMS Request Queue</strong></td>
<td>The name of the request queue</td>
</tr>
<tr>
<td><strong>JMS Response Queue</strong></td>
<td>The name of the JMS request queue</td>
</tr>
<tr>
<td><strong>JMS Transport</strong></td>
<td>Use JMS transport: <strong>Y</strong> or <strong>N</strong>. If you disable JMS transport, the service uses HTTP.</td>
</tr>
<tr>
<td><strong>Keep up to date</strong></td>
<td><strong>Y</strong> or <strong>N</strong>. When enabled, instructs Service Test Management to update the WSDL from its source each time you log in.</td>
</tr>
<tr>
<td><strong>Last Updated</strong></td>
<td>The last time the WSDL was updated</td>
</tr>
<tr>
<td><strong>Service Address</strong></td>
<td>The location of the WSDL file that is displayed by default when importing the service. To override the default address, select <strong>Address Overridden</strong>.</td>
</tr>
<tr>
<td><strong>Service ID</strong></td>
<td>A read-only ID assigned to the service.</td>
</tr>
<tr>
<td><strong>Service Name</strong></td>
<td>The native service name in the WSDL file that is displayed by default when importing the service.</td>
</tr>
<tr>
<td><strong>Toolkit</strong></td>
<td>The toolkit associated with the service. You set this when you import the service and it is read-only.</td>
</tr>
<tr>
<td><strong>WSDL Location</strong></td>
<td>The service deployment location, to which service requests are sent. Quality Center displays by default the endpoint address specified in the WSDL file.</td>
</tr>
<tr>
<td><strong>&lt;user-defined&gt;</strong></td>
<td>If you defined extra fields in customization, they will also appear in the <strong>Details</strong> tab.</td>
</tr>
</tbody>
</table>
Chapter 5 • Managing Services

For services imported through UDDI or Systinet servers, the Details tab shows two additional read-only fields:

<table>
<thead>
<tr>
<th><strong>UDDI Server</strong></th>
<th>The URL address and version of the UDDI server from which the service definition is imported</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Systinet Server</strong></td>
<td>The URL address and port of the Systinet server from which the service definition is imported</td>
</tr>
<tr>
<td><strong>UDDI/Systinet Key</strong></td>
<td>A unique identifier of the service on the UDDI or Systinet server, used to locate the service definition when updating the service.</td>
</tr>
</tbody>
</table>

3 To change the service name in the services tree, right-click a service and choose Rename. Edit the service name and press ENTER.

4 To override the service address declared in the WSDL file or on the UDDI or Systinet server and use a different machine, select the Address Overridden check box, and type a different address in the Service Address box. To revert to the original service address, clear the check box.

**Tip:** Overriding the service address is useful, for example, when the address used for a deployed service is different from that used while the service is being developed.

5 To view or modify the authentication or proxy settings for a WSDL, click Connection Settings. For more information, on configuring connection settings, see “Accessing Services on Secure Sites and Proxy Servers” on page 58.

**Note:** The Connection Settings button is not available for service definitions imported from a file system.

6 To associate a service to a service group, use the Modeling tab. For more information, see “Viewing Group Coverage” on page 84.
When there is a change in the WSDL or a rule violation, Service Test Management generates an alert indicated by an exclamation point. For more information, see “Working with Rule and Change Alerts” below.

**Working with Rule and Change Alerts**

Service Test Management uses alert indicators to make you aware of changes to the service and rule violations.

**To view and resolve alerts:**

1. To view the alert, click on an exclamation point adjacent to a service. The Alerts window opens.

2. In the Alerts window, perform the desired operations:
   - For a change, click **Resolve** to open the **History** tab. You should run the **Create Test Set** utility to resolve the change.
   - For a rule violation, click **Resolve** to open the **Create Requirements Test** wizard. Run the wizard to create the necessary tests.
   - To ignore a change or rule violation, click **Remove All**. When you remove an alert, it only removes the exclamation point—you can still view the alerts at their source. To review WSDL changes or and resolve rule violations, open the **History** tab. See “Reviewing Service Changes” on page 148.
   - To hide a specific change or rule violation, click the collapse icon next to its name.
Managing Service Operations

Operations are the various methods exposed by the service. For example, a Calculator service may include the Add, Divide, Multiply, and Subtract operations.

The Operations tab provides you with a list of:

➤ operations in the service
➤ each operation’s parameters

The Parameter’s grid provides a list of the parameters per operation, their data types, and an indication whether they are input or output.

A Web Service Call utility lets you spot test individual operations, to check its functionality and the validity of its parameters. For more information, see “Spot Testing Operations” on page 76.

To view service operations:

1 Select a service in the tree hierarchy, and click the Operations tab. The tab displays all of the service’s operations.
2 Select an operation to display its parameters in the lower pane. The grid indicates if the parameter is an input or output parameter and its data type.

3 To test an operation of an imported service, click the **Web Service Call** button. This lets you run a spot test on the specific operation as described below.

### Spot Testing Operations

You can use the **Web Service Call** utility to spot test your operations. This utility runs the Manual Runner to check that the operation is functional and that its response is valid. For additional information about Manual Runner, see “Running Service Tests” on page 134.

You use the grid to enter request values and submit them to the server. You can view the SOAP response and export it to a file.

![Spot Testing Operations](image)

To use the **Web Service Call** utility:

1 In the **Services** module, select a service and click the **Operations** tab.

2 Select an operation from the list.
3 Click the **Web Service Call** button. The Run <operation_name> window opens.

4 In the **Grid** or **XML** tabs, enter values for the elements. To import values from an XML file, click **Import XML**.

5 Choose a viewing mode for the request: **XML** or **SOAP**.

6 If the service requires authentication, select the **Security** tab and specify the connection information.

7 To specify an endpoint other than the default, modify the location in the **End Point** box.

8 To run the service and check the response, click **Send Request**.

9 View the response in the right pane’s **SOAP** tab. To save it as an XML file, click **Export SOAP**.

### Adding Attachments to Services

The Attachments tab enables you to associate an attachment with a folder, service, or group. An attachment can be a file, URL, snapshot, an image from the clipboard, or system information. It is identified by its name, associated application icon, size, and latest modification date and time. You can add, modify, and delete attachments.

The **Attachments** tab includes an icon if the selected service or service group has any attachments.

The **Attachments** tab for services and service groups has the same functionality as the Attachments tab for other types. For more information on adding attachments, refer to the *HP Quality Center User Guide*. 
Removing and Restoring Services

You can permanently delete folders or services that are not linked to a test or requirement. To see if a service is linked to a test, see “Checking the Tests Coverage” on page 113. If you try to delete services that are linked to one or more tests, Quality Center transfers them to the Obsolete folder. You cannot copy obsolete services.

You can restore services in the Obsolete folder to their original position in the services tree if the folder still exists in the tree, or you can drag them to a different location in the services tree.

This section describes:

➤ Removing Folders and Services
➤ Restoring Obsolete Services

Removing Folders and Services

If you remove a service folder in the services tree, its subfolders and all the services in the folders are removed. Services contained in the folders are transferred to the Obsolete folder.

To remove a service entirely, you must stop all linked tests from using the service. You can stop a test using a service by opening the test in Service Test, and removing all Web service calls to the service. After you have removed all calls to the service, you can then delete the service from the Obsolete directory.

For more information on viewing linked tests, see “Checking the Tests Coverage” on page 113.

To remove a folder or service:

1 Select the folder or service in the services tree and click the Delete button in the toolbar. Click Yes to confirm.

The folder or service is removed from the services tree. If the service is linked to tests, Quality Center prompts you before continuing: Click Yes to transfer the service to the Obsolete folder, or click No to cancel the operation.
Tip: To view a removed service in the Obsolete folder, refresh the folder. Select the Obsolete folder and click the Refresh All button on the toolbar.

Restoring Obsolete Services

You can restore services in the Obsolete folder to their original position in the services tree, if the folder still exists in the tree. If the folder no longer exists, you can transfer a service to another position in the services tree by dragging it from the Obsolete folder to the required position.

To restore a service:

1. Open the Obsolete folder in the services tree and select the service you want to restore.

2. To view information on the deleted service, click the Details tab.
   The Deletion date box displays the date on which the service was deleted.
   The Deleted from Path box displays the path of the folder where the service was last located.
   For information about other boxes in the Details tab, see “Managing Service Details” on page 71.

3. To restore the service, choose Services > Restore Service. The service is restored to its original location in the services tree.
   Alternatively, select the service in the Obsolete folder and drag it to the appropriate folder in the services tree.
Working with Service Groups

You can organize services into logical groupings, and perform tasks on the entire service group.

This chapter includes:
➤ About Working with Service Groups on page 81
➤ Creating a Service Group on page 82
➤ Viewing and Modifying Service Group Details on page 83
➤ Viewing Group Coverage on page 84
➤ Associating Services to Service Groups on page 84
➤ Mailing Group Information on page 86

About Working with Service Groups

In an organization, services have a context. For example, services may be located on the same server, may be exposed at part of the same application, or may take part in the same business process. In the Services module, you use service groups to organize your services into logical groupings. You might, for example, organize services into groups representing different physical deployments, business processes, or application types such as Enterprise Resource Planning (ERP) or Customer Relationship Management (CRM). After you create service groups, you can assign services to the groups, and perform tasks on the entire service group.

You can send attachments and send e-mails in a similar manner to that of individual services. For more information, see “Adding Attachments to Services” on page 77 or “Mailing Services” on page 68.
Chapter 6 • Working with Service Groups

Creating a Service Group

You can create service groups at the root level of the service or under a specific folder. Quality Center displays the service groups in the tree hierarchy.

To create a service group:

1. Click the Services module in the left pane.

3. In the Name box, enter a descriptive name for the service group (maximum length 255 characters).

4. In the Created By box, click the arrow to expand the box. Select a user or search for one using the search button. Select the View by Group option to see the users in your group.

5. In the Assigned To box, click the arrow to expand the box. Select a user or search for one using the Search button. Select the View by Group option to see the users in the group.
6 Modify the **Creation Date** if necessary.
7 If required, enter text in the **Description** area.
8 Click **Submit**. The new service group is added to the tree hierarchy.
9 To delete a service group, select it and click the **Delete** button in the toolbar.

**Viewing and Modifying Service Group Details**

You can view and modify a service group’s attributes in the Details tab.

**To view or modify service group details:**

1 Select a service group in the service tree hierarchy, and click the **Details** tab to set the following information:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the service.</td>
</tr>
<tr>
<td>Created By</td>
<td>The login name of the user who created the service group.</td>
</tr>
<tr>
<td>Assigned To</td>
<td>The user to whom the service group is assigned.</td>
</tr>
<tr>
<td>Creation Date</td>
<td>The date that the service group was created in the services tree.</td>
</tr>
<tr>
<td>Description</td>
<td>A description of the service group.</td>
</tr>
</tbody>
</table>

2 Modify the information as required.
3 To create requirements and tests for the services in the group, choose **Services > Generate Requirements/Tests**.
Chapter 6 • Working with Service Groups

Viewing Group Coverage

You define requirements and tests for individual services—not for groups. When you associate services with service groups, the group reflects the entities of all its associated services. You can view the complete coverage in the group’s Testing Status tab. Click any of the sections in the Testing Status tab, to see the specific coverage for aspects, requirements, or tests.

For more information, see Chapter 8, “Determining Test Coverage.”

Associating Services to Service Groups

You use service groups to organize your services into logical groupings. You might, for example, organize services into groups representing different physical deployments, business processes, or application types. After you create service groups, you can assign services to the groups, and perform tasks on the entire service group. The same service can be assigned to multiple service groups.
The **Modeling** tab lets you create and view the associations between the groups and services.

To associate a service with a service group:

1. In the **Services** module tree hierarchy, select a group to which you want to associate services.
2. Select the **Modeling** tab.
3. Click the **Select Entities** button to open the Services list in the right pane.
4. Expand the folders and select a service.
5. Click the arrow to open the transfer menu and choose **Associate**.
6. Repeat the above steps for each service you want to associate with the group.
Mailing Group Information

You can send group details by e-mail to other users. This enables you to routinely inform users about the status of the group and its services. The e-mail message includes a link that enables the recipient to go directly to the group.

To mail a group:

1. In the Services tree, select a Service group.
2. Click the **Send by E-mail** button. The Send E-mail dialog box opens.
3. To add a recipient name, type a valid user name. Alternatively, click the **To** button or **CC** button to select users. The Select Recipients dialog box opens.

![](SelectRecipients.png)

You can sort the users list, search for users, group users by user groups, and select users from the list or from a group tree. Select the users or user groups to which you want to send the e-mail, and click **OK**.

4. In the **Subject** box, type a subject for the e-mail.
5. Choose whether you want to include the **Attachments** of the service.
6. In the **Additional comments** box, add any comments you may have.
7. To check the spelling in the dialog box:
➤ Click the **Check Spelling** button to check the spelling for the selected word or text box. If there are no errors, a confirmation message opens. If errors are found, the Spelling dialog box opens and displays the word together with replacement suggestions.

➤ Click the **Spelling Options** button to open the Spelling Options dialog box, enabling you to configure the way spelling is checked.

➤ Click the **Thesaurus** button to open the Thesaurus dialog box and display a synonym, antonym, or related word for the selected word. You can replace the selected word or look up new words.

8 Click **Custom** to customize the e-mail. In the Select Fields dialog box, you can specify fields to include in the e-mail.

9 Click **Send**.

---

**Tip:** To send direct URL links to groups, choose **Copy URL** from the right-click menu and paste it into the mail message. For more information, see “Working with Direct Links” on page 61.
Chapter 6 • Working with Service Groups
Generating Service Requirements and Tests

You can generate service requirements and tests automatically using the Requirement and Test Generation wizard. Alternatively, you can create an empty service test and link it to a requirement. You can then modify the test script.

This chapter includes:
➤ About Generating Service Requirements and Tests on page 89
➤ Understanding Testing Aspects on page 90
➤ Generating Service Requirements and Tests Automatically on page 93
➤ Creating Empty Tests on page 98
➤ Reviewing the Generated Requirements and Tests on page 99

About Generating Service Requirements and Tests

To test your SOA environment, you can create requirements and tests manually, or use the Requirement and Test Generation wizard to automatically generate requirements and test scripts.

The Requirement and Test Generation wizard guides you through the process of creating requirements and scripts to test your services and service groups. Through the wizard, you indicate which aspects of the service you want to test. These aspects include interoperability with different toolkits, boundary testing, and standard compliance.
Chapter 7 • Generating Service Requirements and Tests

After you select the testing aspects, Service Test Management generates a set of requirements, or requirements and tests linked to the service or to services in the service group. Only requirements are linked to services and service groups. The tests are indirectly linked to services or service groups through requirements. These requirements and tests provide pre-packaged testing methodologies and service information that specify which parts of the SOA environment need to be tested, and what to test in each part.

Generated requirements provide a textual description of the testable feature and the expected behavior, based on a template of the specified testing aspects adapted to the selected services. Generated tests describe the test objective and provide an implementation of that testing objective. They include the test operations and arguments for specific testing types. After generating requirements and tests, you can customize them to your particular requirements.

You can also link services and service groups to manually created requirements, and indirectly to tests through requirements. For more information on assigning services and service groups to requirements and tests, see Chapter 8, “Determining Test Coverage.”

Understanding Testing Aspects

The Requirement and Tests Generation wizard helps you create requirements and tests that verify different aspects of your service. Service Test Management creates a separate requirement for each aspect and sub-aspect, and a separate test for each sub-aspect. It only creates a separate test for an aspect if it has no sub-aspects.

By default, Service Test Management supports the following testing aspects:

<table>
<thead>
<tr>
<th>Testing Aspect</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Positive Testing</td>
<td>Generates a full positive test that checks each operation of the service.</td>
</tr>
<tr>
<td>Standard Compliance</td>
<td>Checks the service’s compliancy with industry standards such as WS-I and SOAP.</td>
</tr>
<tr>
<td>Testing Aspect</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Service Interoperability</strong></td>
<td>Tests the interoperability of the service’s operations with all supported Web Services toolkits. Contains the following sub-aspects:</td>
</tr>
<tr>
<td>➤ .NET Framework</td>
<td>Tests that the services are fully interoperable with .NET Framework WSE 2 Toolkit by calling all of its operations with default/expected values.</td>
</tr>
<tr>
<td>➤ Axis/Java Based Web Services</td>
<td>Tests that the services are fully interoperable with Axis 1.3 Web Services Framework by calling all of its operations with default/expected values.</td>
</tr>
<tr>
<td><strong>Security Testing</strong></td>
<td>Tests service security. Contains the following sub-aspects:</td>
</tr>
<tr>
<td>➤ SQL Injection Vulnerability</td>
<td>Checks if the service is vulnerable to SQL injections by injecting SQL statements and errors into relevant parameters.</td>
</tr>
<tr>
<td>➤ Cross-site Scripting (XSS)</td>
<td>Attempts to hack the service by injecting code into a Web site that will disrupt its functionality.</td>
</tr>
</tbody>
</table>
Chapter 7 • Generating Service Requirements and Tests

You can customize the default testing aspects and define additional aspects using Project Customization. For more information, see “Customizing the Services Module” on page 20.

<table>
<thead>
<tr>
<th>Testing Aspect</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Boundary Testing** | Using the negative testing technique, creates tests to manipulate data, types, parameters, and the actual SOAP message to test the service to its limits. Contains the following sub-aspects:  
  ➤ **Extreme Values.** Provides invalid data types to the services and verifies they are not accepted.  
  ➤ **Null Values.** Provides NULL parameters to the services to verify they are not accepted. |
| **Performance Testing** | Contains the following sub-aspects:  
  ➤ **Stress Testing.** Tests the maximum load that can be placed on the application.  
  ➤ **Overload Sustainability Testing.** Tests how well the hardware allocated for the application can support the number of anticipated users.  
  ➤ **Volume Testing.** Tests that the system can handle a massive data entry.  
  ➤ **Longevity Test.** Tests that the system can sustain a consistent number of concurrent Vusers executing transactions using near-peak capacity, over a minimum 24-hour period.  
  ➤ **Scalability Testing.** Repeated stress, overload, volume, and longevity tests with different server or network hardware configurations. |
Generating Service Requirements and Tests Automatically

The Requirement and Test Generation wizard guides you through the steps of creating automatic requirements and test scripts.

To generate service requirements and tests:

1 Open the Requirement and Test Generation wizard.

Select a service or a group in the tree hierarchy, and choose Services > Generate Requirements/Tests.

The Requirement and Test Generation wizard opens and displays the first step.

2 Select the entities you want Service Test Management to generate.

Choose one of the generation options:

➤ **Requirements and tests.** generates a set of requirements, and those tests that are indirectly linked to the service through the requirements. The tests describe the test objective, based on a template of the specified testing aspects. Whenever possible, generated tests provide an implementation of the test objective by describing the test operations.
➤ **Tests only.** generates a set of tests for the aspects you select in the next step.

➤ **Requirements only.** generates a set of requirements for the selected service.

3 **Select a script generator.**

Choose a script generator: **HP Service Test, Manual,** or a custom generator. For more information about using a custom script generator, see Appendix A, “Creating Custom Script Generators.”

Click **Next.**

4 **Specify the testing aspects you want to cover in the generated entities.**

Select the desired testing aspect. To select an entire branch, select the parent aspect. Click **Next** to continue.
Specify where to store the generated entities.

To select a storage location for an entity, click the Browse buttons. The Select <entity> dialog box opens. You can search for, filter, sort, and refresh requirements and test folders in the requirements/test folder tree. Choose the location in Quality Center where you want to store the generated entities.

Click Next to continue.
6 Review the generation summary.

The generation settings that you selected are displayed in a read-only window.

To select different settings, click Back.

To begin the generation process, click Next.
7 View the generation progress.

The generation progress is displayed in the progress bar. If Service Test Management is unable to create a specific requirement or test, it displays a message specifying the nature of the failure.

Review any errors in the Generation status details section.

When the generation process has completed, click Finish to close the wizard.
Chapter 7 • Generating Service Requirements and Tests

Creating Empty Tests

After you create a service in the Services module, you can create an empty test, edit it, and assign it requirements at a later stage. For more information on editing tests, see “Viewing and Editing Service Tests” on page 126.

Tip: You can also create a service test in the Test Plan module. To create a test, select Tests > New Test and select DB-TEST from the Test Type list. For more information, see the HP Quality Center User’s Guide.

To create an empty test:

1 Select a service in the Services tree, and choose Services > Create Empty Test. The Create Empty Test wizard opens.

2 In the Test Name box, type a name for the test.

In the Test Folder box, select a subject folder in the test plan tree.

If the values you entered were valid, Service Test informs you that it successfully created a test.
When creating an empty test, Service Test automatically assigns it default requirements. Use the Requirements module or the Services module’s Testing Status tab to add more requirements. For more information, see “Checking the Requirements Coverage” on page 106.

### Reviewing the Generated Requirements and Tests

After the generation process, you can review the generated entities in the Testing Status tab. This tab also provides full coverage information for each requirement and test. For more information, see Chapter 8, “Determining Test Coverage.”

To remove a test or requirement, select it in the Testing Status tab and click the Delete button.

After generating requirements or requirements and tests, you can do the following:

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit the generated requirements</td>
<td>You can modify the details, attachments, service coverage, test coverage, and defect links for any requirement to suit your specific testing objectives. For example, you might want to define customized thresholds that are not reflected in your service definitions. For more information on defining requirements, refer to the HP Quality Center User’s Guide.</td>
</tr>
<tr>
<td>Edit the generated tests</td>
<td>You can edit the generated scripts to expand their scope and purpose. You can edit manual tests, scripts designed with Service Test, or those created by a third-party vendor. For more information, see “Viewing and Editing Service Tests” on page 126.</td>
</tr>
<tr>
<td>Configure run-time settings for test instances</td>
<td>You can view the script’s run-time settings, and configure run-time settings for test instances in the Test Lab module. For more information, see “Configuring Run-Time Settings from Quality Center” on page 128.</td>
</tr>
</tbody>
</table>
Chapter 7 • Generating Service Requirements and Tests

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configure parameters for test instances</td>
<td>You can configure parameters for test instances in the Test Lab module. For more information, see “Configuring Test Instance Parameters from Quality Center” on page 131.</td>
</tr>
<tr>
<td>Manually set requirements</td>
<td>You can manually set requirements to a service or service group. For more information on linking services to requirements, see Chapter 8, “Determining Test Coverage.”</td>
</tr>
<tr>
<td>Manually add test coverage</td>
<td>You can manually add test coverage to a service or service group. For more information, see Chapter 8, “Determining Test Coverage.”</td>
</tr>
<tr>
<td>Run the Service test</td>
<td>You can run the Service test. For more information, see “Running Service Tests” on page 134.</td>
</tr>
</tbody>
</table>
Determining Test Coverage

Using the Testing Status tab, you can determine the coverage for the service related entities. You can view the coverage on the following levels: aspects, requirements, tests, operations, and defects.

This chapter includes:
➤ About Determining Test Coverage on page 101
➤ Checking the Aspect Coverage on page 103
➤ Checking the Requirements Coverage on page 106
➤ Viewing the Operations Coverage on page 111
➤ Checking the Tests Coverage on page 113
➤ Checking Defect Coverage on page 116

About Determining Test Coverage

You analyze services using charts that display the status of the testing elements: aspects, requirements, tests, and operations. You can analyze either a specific service or all the services in your project.

The Testing Status tab shows the coverage of the requirements and tests as you defined them in the Generate Requirements and Tests Wizard. For more information, see Chapter 7, “Generating Service Requirements and Tests.”
The Testing Status **Dashboard** tab shows a summary of all of the coverage graphs. Aspects, Requirements, Operations, Tests, and Defects. Click on the desired image to view details about its coverage.

<table>
<thead>
<tr>
<th>Dashboard</th>
<th>Aspects</th>
<th>Requirements</th>
<th>Operations</th>
<th>Tests</th>
<th>Defects</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><img src="chart1.png" alt="Aspects Chart" /></td>
<td><img src="chart2.png" alt="Requirements Chart" /></td>
<td><img src="chart3.png" alt="Operations Chart" /></td>
<td><img src="chart4.png" alt="Tests Chart" /></td>
<td><img src="chart5.png" alt="Defects Chart" /></td>
</tr>
</tbody>
</table>

Last Generated: 2/2/2009 11:44:25 AM
Checking the Aspect Coverage

The Testing Status Aspect tab lets you see the coverage of the Testing aspects that were assigned to the service. This information is dynamic and displays the current testing status in percentages. It is useful for the business analyst or system architect who want to see the coverage in meaningful terms.

The following table describes the aspect statuses.

<table>
<thead>
<tr>
<th>Aspect Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Failed</td>
<td>All the aspect’s requirements are assigned the Failed status.</td>
</tr>
<tr>
<td>Some Failed</td>
<td>At least one of the aspect’s requirements is assigned the Failed status.</td>
</tr>
<tr>
<td>All Passed</td>
<td>All the aspect’s requirements are assigned the Passed status.</td>
</tr>
<tr>
<td>Some Passed</td>
<td>At least one of the aspect’s requirements is assigned the Passed status.</td>
</tr>
<tr>
<td></td>
<td>All other requirements have either the No Run, Not Completed, or Not Covered status.</td>
</tr>
<tr>
<td>No Run/Not Completed</td>
<td>All the aspect’s requirements are assigned either the No Run, Not Completed or Not Covered status.</td>
</tr>
<tr>
<td>Not Covered</td>
<td>All the aspect’s requirements are assigned the Not Covered status.</td>
</tr>
</tbody>
</table>
To view the Aspect coverage:

1. Select a service, group, or folder in the tree hierarchy.

2. Select the **Testing Status** tab and click its **Aspects** button. Service Test Management shows a graphic representation of the coverage in the top pane, and a list of the required aspects in the bottom pane. The graph only shows the aspect coverage—not the requirements.

3. Expand an aspect to see its associated requirements.
4 Click on a requirement to open the item in the **Requirements** module.

![Requirements module chart]

For more information about the Requirements module, see the *HP Quality Center* User Guide.

5 To refresh the chart, click the **Refresh** button.
Chapter 8 • Determining Test Coverage

Checking the Requirements Coverage

Requirement coverage is used to connect services to other Quality Center entities (tests, test sets, and defects) through the requirement. This helps you keep track of the relationship between your requirements and services, and ensures compliance with your requirements throughout the testing process. After you have created tests, you associate assigned requirements with tests and defects. In this way, you can keep track of your testing needs at all stages of the testing process. If a requirement changes, you can immediately identify which tests and defects are affected, and who is responsible.

To test services in Service Test Management, you must link them to requirements. When you import a service, you can link the service to an existing requirement, or create new requirements.

To use existing requirements, you drag them from the Requirement entities tree to your Service.

To create new requirements, use the Requirement and Test Generation wizard as described in “Generating Service Requirements and Tests Automatically” on page 93.

The Tests Results > Requirements tab lets you see the coverage of the requirements that were linked to the service. This information is dynamic and displays the current status in percentages. It is most useful for advanced users who understand the Quality Center coverage model and want to integrate Web Service into that model.
The following table describes the requirement statuses.

<table>
<thead>
<tr>
<th>Requirement Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Failed</td>
<td>The requirement test failed.</td>
</tr>
<tr>
<td>N/A</td>
<td>The terms <strong>Passed</strong> and <strong>Failed</strong> do not apply to the requirement.</td>
</tr>
<tr>
<td>No Run</td>
<td>The relevant test was not executed.</td>
</tr>
<tr>
<td>Not Completed</td>
<td>The test for the requirement was not completed.</td>
</tr>
<tr>
<td>Not Covered</td>
<td>The test did not cover the requirement.</td>
</tr>
<tr>
<td>Passed</td>
<td>The requirement was fulfilled.</td>
</tr>
</tbody>
</table>

To manually link requirements to services, see Chapter 9, “Linking Services to Requirements or Tests.”

**To view the Requirement coverage:**

1. Select a service, group, or folder in the tree hierarchy.

2. Select the **Testing Status** tab and click the **Requirements** button.

3. If there are no requirements associated with this service, the screen provides you with the steps you need to follow in order to add requirements.
   
   a. Use the wizard to create requirements. For more information, see Chapter 7, “Generating Service Requirements and Tests.”
   
   b. Click **Select Entities** to open the Requirements tree, and drag an item into the Requirements Coverage grid.
If a service has requirements, the **Testing Status** tab displays a green asterisk. The **Requirements** tab shows a graphic representation of the coverage in the top pane, and a list of the requirements in the bottom pane.

Expand a requirement to see its associated tests. Click on a test to open it in the **Test Lab** module. In the expanded grid, you can drag a test from one parent requirement to another.

**Tip:** Select an entity and open its right-click menu to add requirements or to navigate to the entity.
6 To add more requirements, click Select Entities. Expand the tree in the Requirements tab in the right pane and select the test you want to add to the coverage.

Use the filter button to display only the desired requirements. For example, you can only show the requirements created on a specific date by a specific user.

Click the Add to Coverage button to add the item to the Coverage list or drag it to the Requirements Coverage grid.
Chapter 8 • Determining Test Coverage

7 Double-click on a requirement in the grid to open the item in the Requirement module.

The screen shows the coverage for each of the requirements. To return to your last view, click the Services module button in the left pane.

8 Double-click on a test in the grid to open it in the Test Plan module.

For more information about the Requirements and Test Plan modules, see the HP Quality Center User Guide.

9 To refresh the chart, click the Refresh button.
Chapter 8 • Determining Test Coverage

Viewing the Operations Coverage

The Testing Status > Operations tab lets you see the coverage of the operations per service. This information is dynamic and displays the current status in percentages. This is useful for users of HP Service Test who manually created the test script and need to verify full WSDL coverage.

The following table lists the possible statuses:

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Failed</td>
<td>The test failed for this operation.</td>
</tr>
<tr>
<td>No Run</td>
<td>The test was not run for this operation.</td>
</tr>
<tr>
<td>Not Completed</td>
<td>The test was not completed for this operation.</td>
</tr>
<tr>
<td>Not Covered</td>
<td>The operation was not covered by the test.</td>
</tr>
<tr>
<td>Passed</td>
<td>The test passed for this operation.</td>
</tr>
</tbody>
</table>

To view the Operation coverage:

1. Select a service, group, or folder in the tree hierarchy.
2. Select the Testing Status tab and click the Operations button.
3. Expand an operation to see the status of the tests associated with the operation. In this context, association indicates that:
   a. the test is linked to a requirement which is linked to this service
   b. The test script uses this operation.
4 To set or order the columns in the grid, click the Select Columns button. If an operation uses multiple ports, the grid automatically shows the Port column.

5 Click on a test name in the grid to open it in the Test Plan module.

The screen shows the test's details. To return to your last view, click the Services module button in the left pane.

6 To refresh the list, click the Refresh button.

For more information about the Requirements and Test Plan modules, see the HP Quality Center User Guide.
Checking the Tests Coverage

Tests describe the test objective and an implementation of the testing objective. They include the test operations and the expected outcome of each test. You can generate tests and link them to your services, or you can create a set of tests that are automatically linked to services through requirements (see Chapter 7, “Generating Service Requirements and Tests”).

When linking directly to tests, you link tests to a service in the Tests section of the Testing Status tab. Alternatively, you can link services to tests in the Test Plan module.

Note: You can create coverage between test instances and services using the ALLOW_REQ_COVERAGE_BY_TEST_INSTANCE parameter in Site Administration. For more information about this parameter, refer to the HP Quality Center Administrator’s Guide.

The Testing Status > Tests tab lets you see the coverage of the Tests that were linked to the service. This information is dynamic and displays the current status in percentages.

The following table describes the test statuses.

<table>
<thead>
<tr>
<th>Requirement Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Failed</td>
<td>The test failed.</td>
</tr>
<tr>
<td>No Run</td>
<td>The test was not executed.</td>
</tr>
<tr>
<td>Not Completed</td>
<td>The test was not completed.</td>
</tr>
<tr>
<td>Passed</td>
<td>The requirement was fulfilled.</td>
</tr>
</tbody>
</table>
To view the Tests coverage:

1. Select a service, group, or folder in the tree hierarchy.

2. Select the **Testing Status** tab and click the **Tests** button. Service Test Management shows a graphic representation of the coverage in the top pane, and a list of the tests in the bottom pane.
3 To set the columns you want to display, click the Select Columns button. Select the desired columns, set their order using the up and down arrows, and click **OK**.

4 Click on a test to view the test in the **Test Plan** module.

To return to your last view, click the **Services** module button.

5 To add more tests to the list, click **Select Entries**. Expand the tree in the **Test Plan** tab in the right pane and select the test you want to add to the coverage. Use the filter button to show only the desired tests.

Drag the test to the Test Coverage grid, or click the **Add to Coverage** button.

6 To refresh the chart, click the **Refresh** button.

---

**Tip:** In the grid, click on a Test ID and open its right-click menu to create new tests or to navigate to the test.
Checking Defect Coverage

The Testing Status section Defects tab lets you see the coverage of the defects that were linked to the service. This information is dynamic and is displayed in a chart form, based on the severity of the defects.

You do not link a defect directly to a service. Instead, you link a defect to a requirement or test. If the service was assigned a test that is linked to a defect, Service Test Management displays the defect status in this tab.

To link defects to a test, open the Linked Defects tab in the Test Plan module.

➤ To add a new defect and link it, click the Add and Link Defect button.
➤ To link to an existing defect, click the Link Existing Defect button.

For more information, see the Test Plan module documentation in the Quality Center User Guide.

The following table describes the test statuses.

<table>
<thead>
<tr>
<th>Requirement Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Failed</td>
<td>The test failed.</td>
</tr>
<tr>
<td>No Run</td>
<td>The test was not executed.</td>
</tr>
<tr>
<td>Not Completed</td>
<td>The test was not completed.</td>
</tr>
<tr>
<td>Passed</td>
<td>The requirement was fulfilled.</td>
</tr>
</tbody>
</table>

To view the Defects coverage:

1. Select a service or group in the tree hierarchy.
2 Select the **Testing Status** tab and click the **Defects** button. Service Test Management shows a graphic representation of the coverage in the top pane, and a list of the defects in the bottom pane.

3 Click on a defect to view its details in the **Defects** module. To return to your last view, click the **Services** module button in the left pane.

4 To refresh the chart, click the **Refresh** button.

For more information about the Requirements and Test Plan modules, see the *HP Quality Center* User Guide.
About Linking Services to Requirements or Tests

Requirement coverage is used to connect services to other Quality Center entities (tests, test sets, and defects) through the requirement. This helps you keep track of the relationship between your requirements and services, and ensures compliance with your requirements throughout the testing process.

To test services in Service Test Management, you must link them to requirements or tests.

For information on linking requirements and tests to your services and viewing their coverage, see Chapter 8, “Determining Test Coverage.”
Chapter 9 • Linking Services to Requirements or Tests

Viewing the Requirement Module’s Services Tab

When working in the Requirements module, you can view the services linked to each requirement in the Services tab. The tab contains the following grids:

➤ Covering services. Displays the services linked to the selected test.
➤ Operations in use. Displays the service’s operations that are used by the script. Service Test creates this list automatically and it cannot be edited.

To view the Services tab:

1 In the Requirements module, select a requirement in the tree hierarchy.
2 Click the Services tab. To set column appearance and the order of the columns in the grids, click the Select Columns button.
3 To go to a service in the services tree, click the service link in the Covering services grid. Alternatively, right-click the service and choose Go To Service.
4 To refresh the services in the Covering services grid or Operations in Use grid, click the Refresh button.

Linking Services to Requirements

In addition to linking requirements to services, you can link services to requirements. Using the Requirements module, you access the Services tab to manually associate services and requirements.

To link a service to a requirement:

1 In the Requirements module, make sure you are in the Requirement Details view, accessible from the View menu. Select a requirement, and click the Services tab.
Chapter 9 • Linking Services to Requirements or Tests

2 Click the Select button to open the services tree in the right pane.

3 To search for a specific service in the tree, type the name (or part of the name) of the service in the Find box and click the Find button. If the search is successful, the service is highlighted in the tree.

4 To filter and sort service in the tree, click the Set Filter/Sort button.

5 To refresh the tree, click the Refresh Services Tree button.

6 Select a service to link to the requirement and click the Add Covered Services button. Alternatively, double-click the service. The service is added to the services grid.

7 Click the Close Services Tree button to hide the services tree.

Viewing the Test Lab Module’s Services Tab

You can view services linked to requirements in the Test Lab’s Services tab.

To view the Services tab:

1 Select a test in the tree hierarchy.

2 Click the Services tab. The services grid displays the services that are linked to the selected requirement.

3 To refresh the services in the services grid, click the Refresh button.
4 To set column appearance and order in the Services grid, click the **Select Columns** button.

5 To go to a service in the services tree, click the service link in the services grid or choose **Go to Service** from the right-click menu.

6 To remove a service from the list, select it and click the **Remove a Service** button. Click **Yes** to confirm. This removes all links between the service, requirement, and all related entities.

To view the Requirement Coverage, open the **Services** module and click the **Testing Status** tab. For more information, see “Checking the Requirements Coverage” on page 106.

**Linking Services to Tests**

You can manually link services to a test through the Test Lab’s **Services** tab by adding them to the Covered Services grid.

**To add service coverage manually:**

1 Verify that you are in the **Test Plan** module. Select a test.

2 Click the **Services** tab.

3 In the **Test Plan** module, select the **Services** tab. Click the **Select** button to open the services tree in the right pane.
4 To search for a specific test in the tree, type the name (or part of the name) of the test in the **Find** box and click the **Find** button. If the search is successful, the test is highlighted in the tree.

5 To filter and sort tests in the tree, click the **Set Filter/Sort** button.

6 To refresh the lists of tests in the tree, select the test and click the **Refresh** button.

7 Select a service to link to the test. Drag the service to the **Covered Services** grid or click the **Add to Coverage** button. The **Link <test_name> to Requirement** dialog box opens displaying the requirements linked to the service.

8 Select a brokerage requirement option for linking to the test.

   ➤ **Default Requirement.** Creates a link between the default service requirement and the test if it does not already exist. The linked requirements grid is not available for this option.

   ➤ **Linked Requirement.** Enables you to specify which service requirement to link to the test. Select a requirement from the linked requirements grid. This option is not available if the service or service group has no linked requirements.

To set column appearance and order in the linked requirements grid, click the **Select Columns** button.
To refresh the Covered Services grid, click the Refresh button.

9 Click the Remove a Service button to remove a service. A confirm box indicates whether or not it affects coverage of other entities.
After generating tests, you can modify the details, attachments, service coverage, test coverage, and defect links for any test to suit your specific testing objectives. You can also view the script’s run-time settings and customize the way the Vuser script is run. If a script has parameters, you can assign values to them, or change the existing parameter values from within Quality Center. Note that you can view and customize run-time settings and parameters for a test instance in the Test Lab module only.

Before you run the tests, you create test sets containing these tests. You can then run the tests and view results in the Test Lab module of Quality Center. You can run the tests individually, or you can run them as part of a test set containing multiple tests of all types.
When you run a test, HP Service Test opens and runs the test under the test configuration. When it finishes, Service Test reports the test results back to Quality Center, and saves them as part of the test run.

**Viewing and Editing Service Tests**

After generating the tests, you can view the test script in the Quality Center Test Plan module. If you have installed Service Test on your machine, you can edit tests to suit your specific testing objectives. You can add and remove service operation invocations, update argument data, add validation steps on service responses, and configure security and attachment data.

You edit tests using Service Test depending on your installation. You can open a generated test for editing by launching Service Test for the generated test from Quality Center, or by opening Service Test, and connecting to the Quality Center project to access the generated test. For more information on connecting to Quality Center from Service Test and using Service Test to modify service scripts, refer to the *HP Service Test User’s Guide*. 
To view or edit a service test:

1. Click the Test Plan module button, and select a service test in the test plan tree.

2. Click the Test Script tab to view the test script.

3. Click the Launch button to open the test script in Service Test. You can edit the script directly in the tool and save the changes.
Chapter 10 • Running Service Tests

Configuring Run-Time Settings from Quality Center

You can view the script’s run-time settings and customize the way the Vuser script is run in the Configuration view of the Test Lab module. When you override a script’s run-time settings from Quality Center, the modified settings are saved to the test in Quality Center and do not affect the settings in the Service Test script.

To configure the script’s run-time settings from Quality Center:

1. Click the Test Lab module button, and select the Execution Grid tab.

2. Select a service test, and click the Test Instance Properties button. Alternatively, choose Tests > Test Instance Properties. The Test Instance Properties dialog box opens.
3. In the Test Instance Properties dialog box, click **Configuration** on the sidebar and click the **Automated** tab.
4 In the **Run-Time Settings** section, click **Run-Time Settings**. The Run-Time Settings dialog box opens.

The Run-Time Settings dialog box displays the settings that you set using Service Test. If you did not set run-time settings for a script, the default Service Test settings are displayed.

For information on each specific run-time setting, refer to the *HP Service Test User’s Guide*.

Modifying the run-time settings affects only the test settings in Quality Center. When you modify run-time settings, they are saved for each test within the test plan and do not overwrite the files inside the script.

5 Click **OK** to close the Run-Time Settings dialog box and save the changes.

**Note:** To restore the initial settings, in the Test Instance Properties dialog box, click **Restore From Script**.
6 Click OK to close the Test Instance Properties dialog box and return to the Execution Grid.

7 Run the test or test set. If you modified the run-time settings in Quality Center, the script runs using the modified settings.

### Configuring Test Instance Parameters from Quality Center

You can take a script that has test instance parameters, and assign values to them, or change the existing parameter values from within Quality Center. Since the script is saved in Quality Center, you do not need to change the script each time you replay it. You override the parameter values set in a script from the Configuration view of the Test Lab module.

To change test instance parameters:

1 Click the Test Lab module button, and select the Execution Grid.

2 Select a service test, and click the Test Instance Properties button. Alternatively, choose Tests > Test Instance Properties.
3 In the Test Instance Properties dialog box, click **Configuration** on the sidebar and click the **Automated** tab.
4 In the **Parameters** section, click **Parameter List**. The Parameter List dialog box opens.

You can view and edit the value of each parameter. Any changes that you make to a parameter value are implemented for that specific instance in the next test run.

For more information on working with parameters, refer to the *HP Service Test User’s Guide*.

5 Click **OK** to close the Parameter List dialog box and save the changes.

6 To restore the initial settings, in the Test Instance Properties dialog box, click **Restore From Script**.

7 Click **OK** to close the Test Instance Properties dialog box.
Run the test or test set. If you modified the parameters in Quality Center, the script runs using the modified settings for that instance.

**Running Service Tests**

After you have defined test sets, you can begin executing service tests. You can run an entire test set or specific tests. You can run tests automatically or manually. For more information on running tests automatically, refer to the *HP Quality Center User’s Guide*.

To run a service test manually, open the Manual Runner dialog box, follow the test steps, and compare the expected results with the actual outcome. When a step refers to a service, select its operation and enter its parameter values. You then submit your request to call the operation. After running the request, the results are displayed.
To run a service test manually:

1. In the Test Lab module, select a test set from the test set tree.
2. In the Execution Grid tab, select a service test (DB-TEST test type).
3. Click the Run arrow and choose Run Manually. The Manual Runner dialog box opens and displays the Service Testing tab.

The Steps section displays the first step. The Service Testing section displays the available services and operations.

4. Under Test Steps, follow the instructions detailed in the first test step description.

If a step requires running a service request, under Available Services and Operations, you can expand a service and select an operation to run. For more information, see “Sending Service Operation Requests” on page 138.
Chapter 10 • Running Service Tests

5 To select an execution status for a step, you can:

➤ Click the Pass Selected button and choose Pass Selected Step if the actual result is the same as the expected result. A green check is added to the step and the step status changes to Passed. To pass all the test steps at once, click the Pass Selected button and choose Pass All.

➤ If the actual result is different from the expected result, type the actual result in the Actual Result box, click the Fail Selected button and choose Fail Selected Step. A red X is added to the step and the step status changes to Failed. To fail all the test steps at once, click the Fail Selected button and choose Fail All.

➤ In the Status box, select an execution status. The status can be one of the following: Failed, N/A, No Run, Not Completed, Passed.

6 Click the Next Step button to display the next step.

7 Perform the remaining steps.

8 To specify an endpoint other than the default, modify the location in the End Point box.

9 To add a defect to the test run, click the New Defect button. The New Defect dialog box opens. Quality Center automatically creates a link between the test run and the new defect.

10 To add an attachment, click the Attach to Run button. An attachment can be a file, URL, snapshot of your application, an item from the Clipboard, or system information.
11 To view the test run details, click the Details tab.

![Image of a test run details screen]

Under Run Details, you can edit the following run information:

➤ Run Name. The name of the test run.
➤ Tester. The user name of the person who executes the test.

Under Test Steps, you can review all test steps.

12 Click the Stop button when you complete the test run.
Chapter 10 • Running Service Tests

**Sending Service Operation Requests**

You can submit a service operation request to the server. After running the request, the results are displayed. Service requests can be imported and exported.

**To send a service operation request:**

1. If a step requires running a service request, under *Available Services and Operations*, expand a service and select an operation. The parameters are displayed in the Edit tab.

2. In the *Edit* or *XML* tab, type the expected parameter values. Alternatively, click the *Import* button to import values from a file.

3. To export the parameter values to file, click the *Export* button.

4. To view the SOAP request to be submitted, click the *SOAP* tab.

5. To define an authentication setting method for submitting requests, click the *Security* tab.
6 Click the **Send Request** button to submit the request. The results are displayed under Response, in the SOAP tab.

7 To export the results to file, click the **Export** button.

**Viewing Test Results**

After you have run the test sets, you can verify the service behavior and analyze the results in various formats:

- View a report for each script action and a replay log from the Execution Grid. For more information, see “Viewing the Test Results” on page 140.

- View the results using Quality Center graphs, reports, and documents. For more information, refer to the *HP Quality Center User’s Guide*.

- View service level coverage. For more information, see Chapter 8, “Determining Test Coverage.”.

- Generate Excel reports that enable you to analyze service and service group data from within Excel. For more information, see Chapter 12, “Generating Reports and Documents.”
Viewing the Test Results

After you run a test set, you can view a summary of the test results using the Test Results viewer. The viewer also shows the results of the checkpoints. You can also view a replay log of the test run.

For more information on working with test results, refer to the HP Service Test User's Guide.

To view the Test Results report and log file:

1. Click the Test Lab module button, and select the Execution Grid.

2. To view the Test Results report, click the Launch Report button (only accessible for automatic test runs—not manual ones). If the button is not visible, click the arrow in the bottom right to expand the screen. The Test Results window displays the results for each script action.
Test results are divided into iterations, actions, and steps.

The results report marks a successful step with a green check mark and a failed step with a red X. An iteration is only marked as successful if all of its steps and actions have succeeded.

For Web Service calls, the lower pane of the Results window displays the contents of the SOAP response.

The Results window also shows checkpoint results. It provides a summary with a reason for the failure. It also provides the Expected Value and Actual Results. To view the checkpoint details, expand the appropriate step in the left pane and click the Checkpoint node.

1. To view the replay log, click the View Replay Log button. The test’s replay log is displayed in a text editor. You can examine the messages in the replay log to see whether the test ran without errors.

141
11

Updating Services and Analyzing Service Changes

Change impact analysis helps you minimize the risk of changes in SOA environments by detecting changes to services and establishing their impact.

This chapter includes:
➤ About Using Change Impact Analysis on page 144
➤ The Service Change Workflow on page 145
➤ Updating Services on page 146
➤ Reviewing Service Changes on page 148
➤ Creating Test Sets for Service Changes on page 151
➤ Running Test Sets on page 154
➤ Updating the Change Status on page 154
About Using Change Impact Analysis

Change impact analysis helps you assess the impact of changes to services in your service tests. When you update a service or service group, Service Test Management compares the latest definition from the WSDL file to the WSDL definition stored in Quality Center. If there are changes at the operation signature level or in the data structure of an argument, Service Test Management lists these changes in the History tab. For each change, Service Test Management displays a description of the change, an assessment of the change-risk, and the change status. It also flags the changed service in the services tree.

**Tip:** A green asterisk on the History tab indicates that changes or rule violations are present.

To verify the changes, you can create test sets containing all tests linked to the updated service, or only those tests that are using service operations affected by the changes. Each test set must be linked to a requirement that covers the service. If a service does not have requirement coverage, Service Test Management lets you link the service to a default requirement, which is covered by the test set. All tests in a test set are linked to a service through the requirement.

After creating a test set, you can run the linked or effected tests in the test set to verify whether these changes caused regression in service functionality and performance. You can then determine which entities were affected and who is responsible for them.
Chapter 11 • Updating Services and Analyzing Service Changes

The Service Change Workflow

The Service Change Workflow is an explanation of the steps involved in testing service changes. It contains the following steps:

1 Update a service.

Update the service definition stored in Quality Center with the latest definition from the WSDL file. Service Test Management flags the changed service in the services tree and Services tab. For more information, see “Updating Services” on page 146.

2 Review the changes in the service.

Review the changes in the History tab, and determine their severities based on the change type, description, and change risk. For more information, see “Reviewing Service Changes” on page 148.

3 Evaluate tests.

Evaluate the tests that are associated with the service in the Testing Status tab, and add additional tests if necessary. For more information on tests linked to services, see “Checking the Tests Coverage” on page 113.

4 Create regression test sets to check the changes.

Create a folder for the test sets in the Test Lab module. Use the Create Change Impact Test Set wizard to analyze the impact of change on linked tests. For more information, see “Creating Test Sets for Service Changes” on page 151.

5 Run the test sets.

Run the test sets from the Test Lab module. For more information, see “Running Test Sets” on page 154.

6 Update the change status according to run results.

Verify the behavior of the changed service and manually update the change status in the History tab. For more information on change status, see “Reviewing Service Changes” on page 148.
7 View service coverage.

After all changes have been successfully tested, review the coverage in the Testing Status tab. For more information, see Chapter 8, “Determining Test Coverage.”

8 Update the change status.

After making the necessary adjustments to your tests or services, review the changes again. If you are satisfied with the quality of a service, delete the changes or mark them as Verified or Obsolete. For more information, see “Updating the Change Status” on page 154.

Updating Services

You use the update service feature to check for changes in a service. If changes are found in the service WSDL file, the service definition and operations data stored in Quality Center is updated. You can update the service from the latest WSDL file located at the same location from which the service was imported, or from a different location if the WSDL file was moved. If you update the service from a different file location, you must update the service from the same location type that was originally used (File, URL, UDDI, or Systinet).

You can also update WSDLs that reside on secure locations and WSDLs accessed through proxy servers provided the correct authentication credentials have been supplied. For more information on authentication and proxy settings, see “Accessing Services on Secure Sites and Proxy Servers” on page 58.

You can update individual services from the Services menu. When you update a service, Service Test Management displays changes in the History tab for the selected service, and flags the changed service in the services tree and Services tab. For more information, see “Reviewing Service Changes” on page 148.
Note: If Keep up to date is set to Yes in the Details tab, the service definition is automatically updated from the WSDL file each time the service is loaded.

To update a service:

1. Select the service you want to update in the services tree.

2. Choose one of the following update options:
   - To update a service using the same WSDL location, choose Services > Update Service > Update Service.
   - To update a service using a different WSDL location, choose Services > Update Service > Update Service from. Enter the URL of the WSDL or click Navigate to open a browser to the location of the WSDL.

Note: When updating a service from a UDDI or Systinet server, the selected service must have a WSDL file whose definition has the same service name as the original WSDL used to import the service. You can only select a single service to use as the new source for the import.

3. The Update Service dialog box opens and the update process begins. Service Test Management checks for changes in the WSDL file and informs you if the service was updated.

To automatically close the Update Service dialog box after the update process has finished, select Close dialog box when process finishes.

4. When the update process is finished, click Finish to close the Update Service dialog box.

Tip: If a service is updated, Service Test Management displays a service change alert icon next to the service in the services tree.
Click the service’s **History** tab to view change details. For more information, see “Reviewing Service Changes” on page 148.

**Reviewing Service Changes**

You can view changes to a service in the **History** tab.

The **WSDL Changes** list displays information about each service change, including a description of the change, the part of the WSDL file and service affected by the change, the change status, and an assessment of the change-risk. In addition, you can add, modify and delete service changes from the changes grid. The grid contains the following information:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Part Type</strong></td>
<td>The part of the service affected by the change (<strong>Operation</strong>, <strong>Service</strong>, or <strong>Port</strong>).</td>
</tr>
<tr>
<td><strong>Part Name</strong></td>
<td>The part of the WSDL file affected by the change.</td>
</tr>
<tr>
<td><strong>Change Type</strong></td>
<td>The type of change is indicated as follows:</td>
</tr>
<tr>
<td></td>
<td>➤ <strong>Added</strong>. A service operation was added.</td>
</tr>
<tr>
<td></td>
<td>➤ <strong>Removed</strong>. A service operation was removed.</td>
</tr>
<tr>
<td></td>
<td>➤ <strong>Updated</strong>. Changes were made to the argument structure of the operation. Details of these changes are displayed in the Description column.</td>
</tr>
</tbody>
</table>
You can also display other fields using the *Select Columns* button.

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
</table>
| Change Risk    | The business risks and costs associated with the change. A change can have one of the following risk levels:  
➤ High. Changes that are likely to affect functionality and fail any test that is not updated. High-risk changes include operation removal and parameter changes.  
➤ Medium. Changes may affect functionality, but may not necessarily fail existing tests. Medium-risk changes include service changes (notification that some of the service files have changed).  
➤ Low. Changes are unlikely to fail or affect existing functionality or implemented tests. Low-risk changes include operation additions (as they do not affect existing functionality), service address changes (deployment only), and port type changes. |
| Change Status  | The current status of the change. By default, the change status is New. Update the status throughout the change analysis process as follows:  
➤ New. There is a change in the service.  
➤ In test. The change is being tested.  
➤ Verified. The change was tested and did not cause a regression.  
➤ Obsolete. The change does not affect the service. |
| Creation Date  | The date on which the change was made. By default, the creation date is set to the current database server date. |
| Owner          | The user name of the person who is responsible for the service. |
| Created By     | The user name of the person who run the update that created the changes. |
| Creation Time  | The time at which the change was made. By default, the creation time is set to the current database server time. |
To review service changes:

1. Select a service that has been updated. A service change alert icon next to a service in the services tree, indicates that a service has been updated and contains changes.

2. Click the History tab. The grid lists the changes that were made to the service.

3. To create a test set to verify service changes, click the Create Change Impact Test Set button. For more information, see “Creating Test Sets for Service Changes” on page 151.

4. To eliminate the Alert icon, delete the change or mark it in the Change Status column, as Verified or Obsolete.

To add a change:

1. Click the New Change button. The New Change dialog box opens.

2. Enter the relevant field details.
Chapter 11 • Updating Services and Analyzing Service Changes

3 Click OK to close the New Change dialog box and add the changes to the grid.

4 To add additional changes, repeat the above steps.

To edit a change:

1 Select a change in the grid and click the Change Details button. The Change Details dialog box opens.

2 Proceed through the changes in the changes grid using the browse buttons:

3 Click the First Change button to display the first change, or the Previous Change button to display the preceding change.

4 Click the Next Change button to display the subsequent change, or the Last Change button to display the final change in the grid.

5 Update the details.

6 Click OK to close the Change Details dialog box and save your changes.

7 To delete a change from the changes grid, click the Remove Selected button.

8 To set column appearance and order in the grid, click the Select Columns button.

9 To refresh a change in the grid, select the change and click the Refresh button.

10 To filter, sort, and group changes in the grid, click the Set Filter/Sort button.

Creating Test Sets for Service Changes

After reviewing changes in a service and evaluating the tests affected by them, you use the History tab’s Change Impact wizard. This wizard helps you create test sets to check the impact of the changes. If necessary, you can reduce the total testing effort required by selecting only the tests affected by these changes.

Each test set must be linked to a requirement that is linked to a service. If a service does not have requirement coverage, Service Test Management automatically uses a default requirement. All test instances in a test set are linked to a service through the requirement.
To create an impact change test set for service changes:

1. Select the service whose changes you want to examine.
2. Click the History tab.
3. Click the Create Change Impact Test Set button. The test creation wizard opens.

4. Indicate the Service Coverage: the selected service, or the service and all dependent services.
5. Set the scope for the test set.
   - All tests. Create a test set using all tests linked to the service.
   - Tests affected by the following changes. Create a test set only using the tests that were affected by the selected change(s). Select the changes you want to analyze. Make a multiple selection using the Ctrl key.
Chapter 11 • Updating Services and Analyzing Service Changes

6 Click Next. The grid displays all of the tests or those affected by the change, depending on the specified scope.

7 In the Name box, type a name for the test set.

8 In the Folder box, select the folder under which you want to save the test set you are creating. You cannot add a test set directly to the Root folder.

9 The lower pane displays all the tests included in the test set. To add additional tests to the list, click Select to open the Test Plan tree in the right pane. Expand the tree and use the Add to Coverage button to transfer the tests to the grid.

10 To remove a test from the test set, select it and click the Remove button.

11 Click Finish. The wizard informs you that the test set was created successfully. Click the link to go directly to the test set in the Test Lab module.
Chapter 11 • Updating Services and Analyzing Service Changes

Running Test Sets

After you create test sets to test the impact of changes made to services in a SOA environment, you can run these test sets in Quality Center’s Test Lab module. After you have run the test sets, you can verify the service behavior and analyze the test results using Quality Center graphs, reports, and documents. For details on running test sets and analyzing test results, refer to the HP Quality Center User’s Guide.

After all changes have been tested, review the coverage status of the parent requirement created for the changes set in the Testing Status tab, and verify the changes. For more information, see “Checking the Requirements Coverage” on page 106.

Updating the Change Status

After all the changes have been successfully tested and you are satisfied with the quality of a service, you can update the status for each change, and remove the service change alert icon.

To update a change status:

1 Select an updated service in the services tree, and click the History tab.

2 In the grid, select the change whose status you want to update.

3 In the Change Status column, select a change status:
   ➤ Verified. if the change was tested and did not cause a regression.
   ➤ Obsolete. if the change does not affect the service.

Changing the Change Status to either Verified or Obsolete, removes the Alert icon.

Tip: You can also remove alerts through the Alert dialog box. Click Resolve or Clear All.
You can generate documents and create Excel reports to represent your services and their coverage within Service Test Management.

This chapter includes:
➤ About Generating Reports and Documents on page 155
➤ Selecting Service Entities on page 157
➤ Creating Excel Reports on page 158

About Generating Reports and Documents

Quality Center provides you with several ways to generate summary reports.

Using the standard Document Generator, you can create summary reports of your test plan and requirements. Use the Tools menu to open the Document Generator. For more information, see the Quality Center User Guide.

The Dashboard module lets you generate Excel reports that describe your services.

You design SQL queries within Microsoft Excel. When you generate the report, Service Test Management exports the service and group data and analyzes it from within Excel. Using the capabilities of Excel, you can create tables and display the data in graphical form.

You can also use the extracted data for external applications, such as running a Visual Basic script to process and analyze the data.
Using Built-in Reports

Service Test Management provides several pre-defined reports:

- Active Service Changes
- Outstanding Service Changes
- Rule Violations
- Services By Toolkits
- Services By Type
- Services Coverage
- Services Defects
- Services Per Responsible User
- Services Tests

To generate one of these reports:

1. Open the Dashboard Module and choose the Analysis View tab.
2. Expand the Public folder and select the desired report.
3 Click **Generate** and choose a location for the report.

**Selecting Service Entities**

You can create custom queries on the project's database by choosing service related entities from the Entities list.

Service Test Management adds the following entities to Query Builder's Entities View: **Service**, **Service Aspect**, **Service Change**, **Service Dependency**, **Service Folder**, **Service Group**, **Service Group to Requirement Relation**, **Service Operation to Component Relation**, **Service Operation to Test Relation**, **Service to Group Relation**, **Service to Requirement Relation**, **WSDL Operation**, **WSDL Operation Dependency**, and **WSDL Operation Parameters**. You can create both private queries or public ones that you can share with other users.

For example, you could create a pivot table to summarize Services module data, such as to display in tabular format the status count for the different service coverage statuses.
Once you generate an Excel report, you can use the full capabilities of Excel to display the results in graphical form, such as bar or pie charts.

**Creating Excel Reports**

Quality Center’s *Dashboard* module’s provides an interface for creating reports.

To create an Excel report through a customized query:

1. Open the *Dashboard* module, click the *Analysis View*.
2. Choose *Analysis > New Excel Report*. Specify a name for the report.
3. Click *Query Builder*. Quality Center opens the *Entity View* in the right pane.
4. Select an entity and drag it into the desired location in the Query window.
5. Use the *Test Query* and *Run Query* button to test and run the query.
6. Click *OK* to save the report in the *Private* folder. You can open this report and run the query at a later time.

For more information on how to customize the Excel reports, see the *HP Quality Center User’s Guide*. 
Integration with HP Service Test

HP Service Test integrates with Service Test Management to let you create tests and emulated services to check and assess the quality of applications and services in your SOA systems.

This chapter includes:
➤ Creating Tests with HP Service Test on page 159
➤ Emulating Services on page 160
➤ Using Service Emulation on page 160
➤ Emulating Services from Quality Center on page 161
➤ Using Emulated Services in Vuser Scripts on page 162

Creating Tests with HP Service Test

HP Service Test is HP’s tool for creating functional and load scripts for testing Web Services. Service Test Management works together with Service Test to provide an efficient method for storing and retrieving the scripts, and collecting results. You store Service Test scripts in a Quality Center project and organize them into unique groups. Using Service Test, you create tests for your Web services, edit tests generated using Service Test Management, run tests, view results, and reuse services.

For more information on working with Service Test, refer to the HP Service Test User’s Guide.
Emulating Services

HP Service Test provides a Service Emulation tool for creating an emulation of a service to test other Web services in your environment.

The emulated service lets you design and run tests at early stages of development when the actual service is inaccessible. For example if the development of the service is incomplete or if the service's host is unavailable, you can use an emulated service to test other services in your application.

In the Service Emulation console, you associate a WSDL document to the service which indicates its operations and parameters. You specify rules and delays to define the service's behavior.

For information on creating emulated services with the Service Emulation Console, see the HP Service Test User Guide provided with Service Test.

**Important:** In order to use Server Emulation, you must have a valid HP Service Test license.

Using Service Emulation

Service Test Management provides you with access to the Service Emulation tools. Using the Services > Emulation menu, you can implement service emulations.

To directly access the server hosting the emulated service, choose Services > Emulation > Emulate Service as described in “Emulating Services from Quality Center” on page 161.

To create a new emulated service or to modify the rules for an existing one, use the Service Emulation Console. This requires a Service Test license. Choose Services > Emulation > Run Service Emulation Console. For more information, see the HP Service Test User Guide.
**Emulating Services from Quality Center**

After you create an emulated service, you can call it from Quality Center by specifying the emulation service’s host. You can only emulate a service on a machine that has a Service Test client and license.

**To emulate a service stored in Quality Center:**

1. Start the Emulation Service on the server machine hosting the emulated service. From the Start menu, expand the HP Service Test menu and choose Start Emulation Service.

2. In Quality Center, select the Services module and choose Services > Emulation > Emulate Service. The Specify Service Emulation Host dialog box opens.

3. In the Service Emulation Host Name box, enter the host name.

4. In the Port box, enter the port number.

5. Click OK to emulate the service on the host machine.

Quality Center attempts to connect to the emulation host and create an emulated service. A message is displayed if the service is successfully emulated or if an error occurs during emulation. If the emulation completed successfully, Quality Center overrides the service address to the emulated service address. This allows any script testing that service to run using the emulated service.
Using Emulated Services in Vuser Scripts

After you create an emulated service, you need to integrate it into your test.

To use an emulated service:

1. In the Service Emulation console, select a service in the left pane and copy the WSDL location from the right pane to the clipboard.

2. In Service Test, Open the Service Management window. Select SOA Tools > Manage Services or click the Service Management toolbar button.

3. If you did not yet import a WSDL for the service you want to emulate, click Import. If you have already imported a WSDL, select its corresponding service in the left pane.
Chapter 13 • Integration with HP Service Test

4 Enable the **Override address** option. Paste the WSDL location into the **Service Address** box. During the test run, the service will respond to that location.

The above description shows you how to use the original service’s WSDL, but the emulated service address as the temporary **Service Address**.
Chapter 13 • Integration with HP Service Test
A

Creating Custom Script Generators

Important: This appendix is intended for COM or .NET programmers who want to extend the capabilities of the Requirement and Test Generation Wizard to include custom test generators using an API.

This chapter includes:

➤ Creating Custom Script Generator on page 165
➤ Implementing and Registering a Custom Generator on page 166
➤ Adding Registry Keys on page 167
➤ The Script Generator API on page 168
➤ Test Generation Flow on page 170

Creating Custom Script Generator

The purpose of this feature is to allow programmers to extend the capabilities of the Service Test Management Requirement and Test Generation Wizard.

This API enables you to develop an external script generator through COM or .NET which can be used by Service Test Management during test generation. After you implement the custom generator, Service Test Management adds it to the list of script generators in the Requirement and Test Generation wizard.
When you run the wizard, Service Test Management invokes the API of the custom generator to fill the tests with code, according to the desired logic.

The API includes initialization of the custom generator for the specified aspects and the generation of scripts for tests associated with the service.

Tests created by the custom generator use the custom type name. The required fields are populated by default values and by user provided values. The wizard shows the required fields and their values in the first step.

The Service Test Management installation includes a sample script generator. To create this script generator, run the ScriptGeneratorExampleSetup.msi file in the in the <Service Test Management installation>/ScriptGeneratorExample folder on the server machine. This creates a new script generator titled Custom Manual Tester. This folder also contains project and source files of a .NET sample.

**Implementing and Registering a Custom Generator**

You can implement the script generator as a COM or .NET object. For both COM and .NET implementations, use the IScriptGenerationTaskInfo interface to capture generation task data when reporting generation events.

**COM Object**

When implementing the script generator as a COM object, you must link the project to the SOAClient.dll located in the C:\Program Files\Common Files\Mercury Interactive\Quality Center folder. Implement the following interfaces:

- IScriptGenerator. Implements the script generator mechanism
- IScriptGeneratorCallback. Implements COM events.

**.NET Object**

When implementing the script generator as a .NET object, you must link the project to the StmAPI.dll located in the C:\Program Files\Common Files\Mercury Interactive\Quality Center\client folder. Implement the INetScriptGenerator interface.
Appendix A • Creating Custom Script Generators

Declare the following as COM source interfaces:

➤ IScriptGeneratorCallback
➤ The .NET object

**Note:** You must register the custom generator as a COM object, even if was implemented as a .NET object.

---

**Adding Registry Keys**

In order for Service Test Management to include a new script generator type in the Generation wizard, you need to add it to the registry:

Add a registry key with the name of the generator, under
\HKEY_LOCAL_MACHINE\SOFTWARE\Mercury Interactive\Service Test Management\ScriptGenerators\. For example, \HKEY_LOCAL_MACHINE\SOFTWARE\Mercury Interactive\Service Test Management\ScriptGenerators\CustomGenerator.

The key should have the following values:

➤ **COM ID.** A string value, set to the COM ProgID, used to create the COM object. This is the COM object that implements the above interfaces and logic.

➤ **Test Type.** A string value, set to the Quality Center test type that the custom generator supports. For example, **MANUAL** or **DB-TEST**.

➤ **Name.** A string value, indicating the name to display in the list of test generators in the first step of the Generation Wizard.

➤ **Description.** A string value, describing the custom generator. This is currently not used, but reserved for future implementations.

➤ **Supported Version.** A dword value, specifying the version of Service Test Management supported by the custom generator. Set this value to 10.
Appendix A • Creating Custom Script Generators

The Script Generator API

The following section shows the API of the StmAPI.dll.

IScriptGenerator Interface

The following is the object definition:

```
object,
uuid(B60C546F-EE91-48a2-A352-CFC36E613CB7),
dual,
nonextensible,
helpstring("IScriptGenerator Interface"),
pointer_default(unique)
```

This section provides the interface:

```
interface IScriptGenerator : IDispatch{
    [helpstring("Init the Script generator")]
    HRESULT Init();
    [helpstring("Set generation parameters")]
    HRESULT SetGenerationData([in] IList *SelectedAspects, [in]
    SAFEARRAY(VARIANT) AdditionalData);
    [helpstring("Report how many tests are required for a given service, and a given
    aspect, according to already set aspects and additional data")]
    HRESULT EvaluateTestCount([in] IService *Service, [in] IServiceAspect
    *Aspect, [out] int *TestsCount);
    [helpstring("Start generation for a given service")]
    HRESULT StartGenerationForService([in] IService *Service, [in] IList *Tests);
    [helpstring("Stop all current generation")]
    HRESULT StopGeneration();
    [helpstring("General purpose error reporting")]
    HRESULT GetLastError([out] BSTR *Error);
};
```
Appendix A • Creating Custom Script Generators

**IScriptGenerationTaskInfo Interface**

The following is the object definition:

```plaintext
object,
uuid(73C9EFD1-3B4C-4fbb-AF29-2AB59E6ABACB),
dual,
nonextensible,
helpstring("IScriptGenerationTaskInfo Interface"),
pointer_default(unique)
```

This section provides the interface:

```plaintext
interface IScriptGenerationTaskInfo : IDispatch{
    [propget, helpstring("Task status message")]
    HRESULT StatusSucceeded([out] VARIANT_BOOL *Success);
    [propget, helpstring("Task error message")]
    HRESULT ErrorMessage([out] BSTR *Error);
    [propget, helpstring("The id of the generation aspect this task is handling")]
    HRESULT AspectID([out] int *AspectID);
    [propget, helpstring("The id of the generated test this task is handling")]
    HRESULT TestID([out] int *TestID);
    [propget, helpstring("The name of the generation aspect this task is handling")]
    HRESULT AspectName([out] BSTR *AspectName);
}
```

**IScriptGeneratorCallback Interface**

The following is the object definition:

```plaintext
object,
uuid(BEEE5AA8-002E-4221-B99B-6E592F23E17E),
dual,
nonextensible,
helpstring("IScriptGeneratorCallback Interface"),
pointer_default(unique)
```
This section provides the interface:

```csharp
interface IScriptGeneratorCallback : IDispatch{
    [helpstring("Generation task started")]
    HRESULT TaskStarted();
    [helpstring("Generation task ended")]
    HRESULT TaskEnded([in] IScriptGenerationTaskInfo *TaskInfo);
};
```

## Test Generation Flow

The following section describes the flow of actions Service Test Management performs while creating tests through a custom script generator:

1. Creates the custom generator through its COM registration (even for .NET objects).

2. Registers the generation events. If the custom generator is a COM object, register them through Advise. For a .NET object, register the .NET events directly.

3. Calls `Init` to run all initialization code before the actual generation process.

4. Calls `SetGenerationData` with the selected aspects as the first argument and null as the second argument. The `AdditionalData` argument is not used, and reserved for the future. The custom generator uses this call to store the selected aspects and prepare for generating scripts for these aspects.

5. Starts the generation process in a new thread, to keep the user interface active.

6. Loops through the selected service or service group. For each service, Service Test Management:

   a. Loops through the selected aspects and calls `EvaluateTestCount` for the service and each of its aspects. The custom generator implements this method to return the number of tests to generate for that service and aspect. This is usually one test, but it can also be a multiple number of tests.
Appendix A • Creating Custom Script Generators

b Creates the tests and initializes their fields' values. It posts the tests so that the custom generator receives actual, not virtual, tests.

c Calls StartGenerationForService for the current service and its tests for each of the aspects.

d The custom generator creates the test scripts using the OTA API or any other third party API. As these are actual tests, the custom generator can read and write to their fields, upload attachments, and so forth.

e During script generation, the custom generator should invoke the TaskStarted event before generating each test and the TaskEnded event after completing the test generation. The status of the script generation for that test should be reported in TaskEnded TaskInfo argument (implementing the IScriptGenerationTaskInfo interface), indicating the following values:
  ➤ Status of the task
  ➤ Error message (if applicable)
  ➤ Aspect ID
  ➤ Script Name
  ➤ Test ID

f Service Test Management displays the data and stores the information to make it available for other uses, such as linking the test with requirements.

g Service Test Management posts the tests again, committing any changes to their fields' values.

h If requirements were also generated through the wizard, Service Test Management links the tests to their respective requirements.

Note: The StopGeneration and GetLastException methods are currently not in use.
Index

A
accessing the Services module 35
Add Change task 30
Add Covered Service button
   Services tab 121
Add Group task 30
Add Service Folder task 30
Add Service task 30
Add to Coverage button 123
Adobe Reader 12, 14
alerts 74
analysis, change impact 144
aspects
   managing 23
testing 90
Aspects tab 23
Attachments tab, Services module 39, 64
authentication settings 58
Axis/Java based Web services 91

B
bitmap checkpoint customization 165
bitmap checkpoints
   customizing 165
Boundary testing
   extreme values 92
   null values 92

C
call operation 76
Change Details dialog box 151
change impact analysis 144
Change Risk, History tab 149
Change Status, History tab 149
change status, updating 154
Change Type, History tab 148
Check Spelling button
   Send Mail 69, 87
Configuration view 128
connection settings
   authentication 58
   proxy 58
Connection Settings dialog box 59
Connection Settings, customization 21
copying services 67
copying, folders, services or groups 67
coverage
   aspects 103
dashboard 101
defects 116
operations 111
requirements 106
tests 113
coverage grid
   Services tab 121
Create Definition Manually button, services
   tree 48
Create Empty Test wizard 98
Created By
   History tab 149
creating empty tests 98
Creation Date
   History tab 149
Creation Time, History tab 149
Cross-site Scripting (XSS) 91
Custom button 70, 87
custom generator
   registering 166
   registry keys 167
custom script generator 165
customization
   Connection Settings 21
Index

default requirements 22
default Systinet server 21
default UDDI server 22
toolkit order 22

Customize Service Test task 31
customizing
  service entities 31
  service group entities 31
  Services module settings 20
  user group permissions 29

D
dashboard for coverage 101
defects
  coverage 116
defining custom 26
Delete Change task 31
Delete Group task 30
Delete Service Folder task 30
Delete Service task 30
deleting services 78
dependencies, defining for services 57
Description
  History tab 150
Details tab
  getting started 38
  managing services 71
direct links to services 61
Documentation Library 11

E
e-mailing services 68
Emulate Service task 30
emulated service
  from Quality Center 161
  in Vuser scripts 162
Excel reports 157

F
filter rules 25
filtering services 65
Find Folder/Service command 66
Find Folder/Service dialog box 66
finding folders and services 66
folders, copying 67
fuzzy logic 20

G
generic toolkit (deprecated) 91
Getting Started 12
Go To Service command 120
groups, copying 67

H
Help on this page command 11
History tab
  change analysis 148
  getting started 38
  managing services 64

I
impact of change 144
Import from File button, services tree 48
Import from Systinet button, services tree 48
Import Services button, services tree 37
importing service definitions
  from file system 48
  from Systinet 51
  from UDDI 50
  from URL 49
importing, service definitions 44
instance of test 131
IScriptGenerationTaskInfo 169
IScriptGenerator 168
IScriptGeneratorCallback 169

J
JMS request queue 72
JMS transport 72

K
key, for UDDI or Systinet 73

L
Link Service to Requirements task 30

174
linked services, creating 55
linking services to requirements 120
links 61
Longevity testing 92

M
mailing services 68
Manual Runner 134
manually defining a service 53
menu bar, Services module 37
Modeling tab 39
Modify Change task 30
Modify Group task 30
Modify Service Folder task 30
Modify Service task 30

N
New Aspect dialog box 23
New Change dialog box 150
New Folder button, services tree 37
New Folder dialog box, services tree 43
New Manual Service dialog box 54
New Service dialog box 54

O
obsolete services 79
operations
calling 76
coverage 111
requests 138
Operations tab
getting started 38
managing 75
Overload testing 92
overriding
service address 73
Systinet address 73
UDDI address 73
Owner, History tab 149

P
Parameter list 133
Part Name, History tab 148
Part Type, History tab 148
Performance testing
longevity 92
overload 92
scalability 92
stress 92
volume 92
Permission Settings dialog box 29
permissions, changing 29
pivot table 157
policies, see rules
Positive Testing 90
proxy settings 58

Q
Quality Center, Service Test integration 159
query builder, for Excel report 157

R
Readme 14
Refresh button
   History tab 151
Refresh Selected button, services tree 38
registry keys 167
registry, Systinet 16
Remove from Coverage button 124
Remove Selected button, Linked Req tab 122
removing services 78
renaming services 67
reports, Excel 157
required fields 31
Requirement and Test Generation wizard 93
requirements
coverage 106
customizing default requirements 22
generating 93
viewing Services tab 121
restoring obsolete services 79
results, of test run 139
rule alerts 74
rules 25
running service tests 134
run-time settings 128
Index

S
Scalability testing 92
script generator, custom 165
Security testing
cross-site scripting (XSS) 91
SQL injection vulnerability 91
Select button
   Services tab 121, 122
Select Entities to Generate 93
Select Fields dialog box 70, 87
Select Recipients dialog box 69, 86
Select UDDI Service dialog box 50
Send by E-mail button, services tree 38
Send by E-mail dialog box 68
service dependencies
   creating 55
service emulation
   overview 160
service groups
   assigning services to 84
   coverage 84
   creating 82
   viewing properties 83
Service Interoperability testing
   .NET Framework 91
   Axis/Java based Web services 91
genetic toolkit (deprecated) 91
Service name, WSDL Definition tab 72
service operation requests 138
service rules 26
Service Test
   creating tests with 159
service testing, overview 15
service tests
   creating empty test 98
   running 134
   submitting operation requests 138
services
   adding attachments 77
   address 72
   copying 67
   creating folders 43
   deleting 78
   e-mailing 68
   finding 66
   importing 44
importing from file system 48
importing from Systinet 51
importing from UDDI 50
importing from URL 49
linked 55
linking to requirements 120
linking to tests 122
manual 53
manually defining 53
modifying 65
Operations tab 75
providing definitions 71
removing 78
renaming 67
restoring 79
updating 146
services folders, creating 43
Services module
   accessing 35
   customizing 20
   menu bar 37
   tabs 38
   toolbar 37
   window 35
   window elements 37
Services tab
   Permission Settings dialog box 29
Test Plan module 120
services tree
   adding new folders 37
   adding new services 37
   creating 43
   deleting services and folders 38
   importing service from file 48
   importing service from Systinet 48
   mailing services 38, 68
   manually create service definition 48
   refreshing services and folders 38
   setting filter/sort 38
Set Filter/Sort button, services tree 38
Severity, History tab 150
shortcut to views 61
sorting services 65
Spelling Options button, Send Mail 69, 87
spot testing 76
SQL injection vulnerability 91
Index

Standard Compliance testing 90
Stress testing 92
Systinet
  customizing the default settings 21
  importing service definitions from 51
Systinet Key 73
Systinet registry 16

T
  tabs, Services module 38
  tasks, changing permissions 29
  td links 61
  test instance parameters 131
  test results
    replay log 140
    viewing 139
  test sets
    running 154
  test sets, creating 151
  testing aspects
    default 90
    managing 23
  Testing Status tab 38, 101
  Testing Status tab, Service module 64
  tests
    coverage 113
    creating empty 98
    generating automatically 93
    linking services to tests 122
    running 134
    submitting operation requests 138
  Thesaurus button 69, 87
  toolbars, Services module 37
  toolkits, customizing the order 22

U
  UDDI
    customizing the default settings 22
    importing from 50
    key 73
  Update Service dialog box 147
  Update Service/Group task 30
  updating services 146
  URL, importing services 49

user group
  setting permissions 29
user-defined fields, customizing 31

V
  violations 25
  Volume testing 92
  Vuser scripts, Quality Center integration 159

W
  What’s New command 12
  WSDL file
    importing 48
    location 72
    managing 72
Index